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Welcome!

Welcome!
Welcome to the online Help for CAST Release Builder. This help system provides instant support
for and knowledge about Release Builder, CAST's database management environment.
Getting Help
To access CAST online Help directly from the application:
●

Click Help > Index

You can also access specific topic pages by clicking the Help button in dialog boxes or by using
the F1 key. For more information on using the online Help system, click here.
Getting Started
To get started with the CAST online Help, take a look at the How To... section, which describes
how to carry out basic functions in Release Builder, or navigate to the Features section, which
provides detailed information about the various Release Builder features.
Current Help Version
See here for more information.
See Also
Contacting CAST - Office Locations | Related Help and documentation | Release Notes | About |
Copyright Notice
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Using Help

Using Help
This help system, based on Microsoft HTML Help, makes use of the latest technology to provide
you with in-depth and easily accessible information. It provides both general and more detailed
descriptions about all the available features of the application.
Key features of CAST's online Help system:
●

●

●

●

●

●

●

The Contents tab shows you the exact location of the current topic. Use the auto-sync
feature (Locate button) to identify your position within the Help system.
The interactive Index and full-text Search capabilities allow you to quickly reach the
information you need.
A Favorites tab enables you to store pages that you use regularly and even allows you to
rename pages for easy identification.
If you find reading from paper more comfortable, you can print the current topic
icon) or an entire section ( ), by using the Print command
(represented by the
located on the toolbar.
The button hides more detailed information. Click the button or the associated link to
reveal the required information.
The

button can be clicked to hide a topic.

Clicking the
again to hide them.

button will display all hidden topics in the current page. Click

To start your exploration, please choose a topic to view from the table of contents (Contents
tab).
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Related Help and documentation

Related Help and documentation
●

PDF format > this Help system can be made available in Adobe Acrobat PDF format.
Please contact CAST if you require it.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/RELBLD/Welcome/related.htm [10/07/2008 11:31:11]

Contacting CAST - Office Locations

Contacting CAST - Office Locations
For Sales, Product Support or General Inquiries, please contact our headquarters or your regional
office directly by calling us or filling in the quick email form.
Because CAST is continually growing and expanding, please also consult the CAST Web Site for
an up-to-date list of our office locations.
Headquarters
CAST Corporate and Europe Headquarters
Address: 3, rue Marcel Allégot
92190 Meudon
France
CAST North America Headquarters
Address: 373 Park Ave So.,
5th Floor
New-York, NY 10016

Access Map
Phone: +33 1 46 90 21 00
Fax: +33 1 46 90 21 01

Access Map
Phone: Phone: +1 212 871
Fax: 8330
Support: Fax: +1 212 759 3772
Support: +1 877 852
2278 ext. 135

Sales Offices
Belgium - Brussels
France - Paris
Germany - Munich
Italy - Milan
Spain - Madrid
UK - London
US - Washington DC
US - New York
US - Chicago
Other countries - CAST Channel Partners
Scandinavia
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Contacting CAST - Office Locations

All other countries
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Release Notes

Release Notes
CAST provides a set of Release Notes for each version of products it ships.
Please make sure you read these as they contain important late-breaking information, known
issues and other technical information not available prior to shipping.
Notes
●

If you cannot find or access the Release Notes, please contact CAST who will supply them
for you.
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About

About
CAST provides an About dialog box that displays technical information about:
●

the application module name, together with its current version and build number

●

the addresses and contact details of the main CAST Offices

●

the connectivity layer in use

●

the machine identification number

●

the host name

Report button
Clicking the Report button will display a further dialog box providing much more detailed
technical information (known as the CAST Diagnostic Report). This can be particularly useful if
you need to troubleshoot or debug with CAST.
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About

●

●

Connectivity Layer Information > This will launch the Info dialog box
Save file... > Allows you to save the contents of the CAST Diagnostic Report in HTML
format

If you do not want this connection report to be displayed in an HTML format, please add this
script to your GloballySharedSettings.ini file:

[Report]
Report in Dialog Format = 1
Notes
●

Please note that in CAST Server Manager only, this report can also be displayed using the
Database/Schema Installation > Troubleshooting > Diagnostic Report option

See Also
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About

GloballySharedSettings.ini File
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How To...

How To...
●

Launching Release Builder

●

Open a concurrent connection

●

Saving the configuration

●

Importing/Exporting Release Profiles

●

Editing with Release Builder

●

Sending Files to SQL-Builder

●

Managing Multi Database Scripts
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Launching Release Builder

Launching Release Builder
Client Identification dialog box
The very first time you launch Release Builder, the application may ask you for an Identifier.
This is simply a hostname that identifies your client machine to the server.
All you need to do is to enter an Identifier in the appropriate field which can be up to 10
characters long. You can use your existing client name if you want, or the last 10 digits of
your IP address if this is more convenient.
When you run the SQL command sp_who in your SQL IDE, you will then see this identifier under
the hostname column in the returned results as displayed below:

" spid
...
6

status

loginame

running sa

WESLEY

hostname

blk

0

SELECT "

master

dbname

cmd

What next?
When you are satisfied with the identifier you have entered, click the OK button.
The dialog box will then close and the normal connection procedure will continue. If you want to
abort the process, click the Cancel button.
Notes
●

The Client Identification dialog box is only displayed when you FIRST launch the
application - subsequent launches will go straight to the Open Profile Connection dialog
box.

Connecting to a server
Once you have confirmed your Identifier in the Client Identification dialog box and if you have
not previously created a Connection Profile, you may be prompted for to create a new profile
(click Yes).
1. The Add/Edit Connection Profile dialog box will be displayed enabling you to enter the
server connection parameters into your Connection Profile.
2. When you have entered all the required information, tested the connection and clicked
OK, the Connection Profile will be stored by the application. In addition, the Profile will be
automatically displayed in the Open Profile Connection dialog box.
3. Double-click the Connection Profile to connect to the server defined in the Profile.
4. If the parameters you defined are accepted, a connection to the server will be opened
and the Assistant will automatically launch allowing you to select the functionality you
want to use.
If for some reason no connection with the server can be established, a warning message will
appear. In addition a message will appear in the Messages & Errors List to explain the likely
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Launching Release Builder

cause of the failure and to help you rectify the problem.
Automatic Connection
You can configure Release Builder to create a connection automatically on start-up. See the
Connection tab for more information.
See Also
Connection | Assistant | Connection tab
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Open a concurrent connection

Open a concurrent connection
In some circumstances, your organization may need to work with more than one server. If this is
the case, you may need to connect to another server during a session.
To do so:
1. Click File > New Connection Report.
2. If you have already established a connection to a server, the Connection Manager dialog
box will then be displayed.
3. Click New to define new connection parameters.
4. The Open Profile Connection dialog box will then be displayed. Select the Connection
Profile you require and click Open.
5. Release Builder will then attempt to connect to the selected Connection Profile.
6. If the connection fails for any reason, check the Log List for more information.
Notes
●

You can also use the shortcut keys CTRL+N or the

button to open a new connection.

See Also
Connection | Connection Manager dialog box | Open Profile Connection dialog box
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Saving the configuration

Saving the configuration
You can save the current configuration (all options set in the General Configuration Tabs) to the
RBO.ini/RELBUILD.ini file. These options will automatically be reloaded during subsequent
sessions.
You can save the options immediately or on exit from the application:
1. Select Options > Save Configuration Now or Save Configuration on Exit (SQLServer version only) as appropriate (located on the menu bar).
2. Selecting the Save Configuration Now option will save the current options to the local
application INI file.
3. Selecting the Save Configuration on Exit (SQL-Server version only) option will place a
check mark next to the menu option and cause the options to be saved to the local
application INI file when you exit Release Builder. Uncheck this option if you no longer
want the options to be saved to the local application INI file on exit.
Notes
●

Options saved to the local application INI file will be automatically reloaded during
subsequent sessions.

See Also
General Configuration Tabs
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Importing/Exporting Release Profiles

Importing/Exporting Release Profiles
Release Profiles are a way of storing information about databases on your server in an offline file
based manner. They can then be used in a number of the Release Builder processes instead of
using a live connection to a server (for example you can compare a Release Profile (of a
database) with a live database in the Database Comparison Assistant).
Release Profiles can be managed in the Release Profile Manager and can be created in the Script
Extraction Assistant.
As part of the management process, you can export or import a Release Profile (.RPF file) to or
from a text file (.TXT).
Exporting a Release Profile to a .TXT file
1. Open the Assistant (SQLServer > Release Builder Assistant).
2. Select the Profile Features tab and choose Export Profile.
3. Locate the .RPF file using the Windows standard Open dialog box.
4. The Export Profile dialog box will then be displayed.
5. Choose a name and location for your output text file (Release Builder will automatically
choose one for you).
6. Click OK to start the export procedure.
Importing a Release Profile to a .RPF file
1. Open the Assistant (SQLServer > Release Builder Assistant).
2. Select the Profile Features tab and choose Import Profile.
3. Locate the Release Profile in text form (this file must be the result of a previous export
process - or has been created manually with the same format) using the Windows
standard Open dialog box.
4. The Profile Import Wizard will then be displayed. Follow the instructions there.
5. Click Build Profile to start the importation procedure.
See Also
Export Profile dialog box | Profile Import Wizard
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Editing with Release Builder

Editing with Release Builder
Release Builder provides various editing options enabling you to edit scripts generated during
any of the Release Builder processes.
New SQL Script command (File menu)
Open File command (File menu)
Edit Current File command (File menu)
See Also
Sending Files to SQL-Builder
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Sending files to SQL-Builder

Sending files to SQL-Builder
Release Builder integrates seamlessly with CAST's SQL development environment, allowing you to
edit scripts via CAST's built in SQL-Session (scripts can then be run immediately against the
chosen server).
To do so:
1. First highlight any file name from the Report window.
2. Select File > Send File to SQL-Builder.
3. CAST SQL-Builder will then be launched enabling you to take advantage of the built-in SQLSession to edit your .SQL script file.
4. You can also launch this option with the toolbar button
See Also
Editing with Release Builder
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Managing Multi Database Scripts

Managing Multi Database Scripts
To learn how to manage the extraction and the execution of scripts related to more than one
database, please follow these few steps:
1. First of all, you need to create one Release Profile for each database concerned. To do
this, open a connection with New from the File menu (through the Open Profile
Connection dialog box) and open the Script Extraction Assistant from the SQLServer
menu.
2. For each database, select the name of that database and choose the Save Profile button
from the Scripts Destination Files Wizard. In the dialog box entitled Current Release Profile
dialog box enter a file name for the profile and click Save. You have now created a profile
containing the image of the selected database.
3. When you have created the profiles, launch the Release Profile Manager from the
SQLServer menu. In the Release Profile Manager dialog box, you should see the profiles
you have just created in the list (if not, use the Browse button to select the right
directory).
4. Select these profiles and click the Start Extraction(s) button. You will be asked for a file
where all of the cross referenced constraints will be generated (the default is "x-refs.sql"),
and prompted before the loading (and execution) of each profile.
5. At the end of the process, you should see a report containing a reference to every
generated file. If you need to run these scripts, double click each of the file names
(starting from the beginning of the report) and choose the Send File To SQL-Builder in the
File menu to start the execution of the scripts (with SQL-Builder).
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Features

Features
The Features section provides in-depth knowledge and information about Release Builder's
key features. Select an item listed below to find out more.
●

General Configuration Tabs

●

Connection Information

●

Application Interface

●

Assistant

●

Script Extraction Assistant

●

Database/Schema Comparison Assistant

●

Command Line Assistant

●

BCP Transfer/Bulk Copy

●

Miscellaneous Items

●

Source Manager Interface
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General Configuration Tabs

General Configuration
●

What are the General Configuration tabs?

●

Connection tab

●

Script Extraction tab

●

Object Selection tab

●

Database Compare tab

●

BCP Transfer tab

●

General Settings tab

●

Editor Options tab

●

Editor Font tab

●

Messages & Errors tab

●

Saving the configuration
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What are the General Configuration tabs?

What are the General Configuration tabs?
The General Configuration tabs provide a range of options for configuring various aspects of the
application.
To access the General Configuration dialog box:
1. Click Options > General Settings
2. Select the appropriate tab
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Connection tab

Connection tab
Options > Connection Parameters

This tab enables you to define various connection parameters.
Connection Parameters
System Objects
See Also
Connection Information | Launching Release Builder
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Script Extraction tab

Script Extraction tab
Options > Script Extraction

This tab enables you to configure options for the Script Extraction process.
Script Content
Owner Specification
Source Manager - Build from Archive
Extraction Process
Messages & Warnings
Release Profile
Collation (SQL-Server 2000)
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Script Extraction tab

See Also
Script Extraction Assistant | Send File to SQL-Builder | Dropped Object List dialog box
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Object Selection tab

Object Selection tab
Options > Object Selection

The Object Selection tab contains the settings that affect the display of information in the
Script Extraction Object Selection Wizard.
Object List Contents
Automatic Selection
Messages & Warnings
Miscellaneous
See Also
Script Extraction - Object Selection Wizard
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Object Selection tab
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Database Compare tab

Database Compare tab
Options > Database Compare

The Database Compare tab contains various settings for a Database Comparison process.
These settings are stored in a template so that you can reuse them in subsequent sessions (for
example in the Database Comparison Assistant or in the Command Line Assistant). You can
create as many templates as you require (see Templates below) and each template can contain a
variety of different options.
Templates
Comparison Scope
Object Comparison based On
Table Data Handling
Text Object Comparison
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Database Compare tab

Consider
Miscellaneous
See Also
Database Comparison Assistant | Confirm Script Contents dialog box
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BCP Transfer tab

BCP Transfer tab
Options > BCP Transfer

The BCP Transfer tab contains the settings for the BCP Transfer/Bulk Copy process.
Row Count Display
Messages & Warnings
BCP Process
Text Mode Default File Format
Display Option
Default Format
See Also
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BCP Transfer tab

BCP Transfer/Bulk Copy process
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General Settings tab

General Settings tab
Options > General Settings

The General Settings tab contains various general settings.
Script Editing
File Names
Assistants Configuration
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Editor Options tab

Editor Options tab

The Editor Options Tab governs how the information is displayed in the SQL Script window.
Keyword preprocessor
Miscellaneous
Tab settings
Syntax coloring
See Also
Editor Font tab
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Editor Font tab

Editor Font tab

The Editor Font Tab governs how text is displayed in the SQL Script window.
Main
Effect
Normal Text Color
Selected Text Color
See Also
Editor Options tab | Report window
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Messages & Errors tab

Messages & Errors tab
Options > General Settings...

This tab enables you to configure various options for the errors and messages that are saved to
an external file. These messages are also displayed in the Messages and Errors List.
General Options
Log Options
Other options
See Also
Messages and Errors List
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Connection Information

Connection Information
●

Connecting with Release Builder

●

Knowledge Base connection

●

Info dialog box

●

Connection Manager dialog box

●

Connection Profiles
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Connection Information

Connection Information
●

●

●

●

●

●

Release Builder is a database comparison and release management environment, so you
can use it to connect to any supported Microsoft, Sybase ASE or Oracle server on which
you have sufficient permissions (please refer to the "Release Notes" supplied with the
CAST Products' CD-ROM for more information on supported versions).
Connections are defined in Profiles, enabling you to create any number of different
connection configurations (specifying servers, usernames and passwords) to a variety of
different servers. Connection is simply a matter of selecting and opening a valid Profile (all
valid Profiles will be displayed in the Open Profile Connection dialog box). Usernames must
be defined in your server prior to connection with Release Builder.
The username you use to connect and its associated permissions will determine the level
of access you have on the server.
Concurrent connections are possible with Release Builder - see Opening a concurrent
connection.
When a connection to a server has been established, server messages will be displayed in
the Messages and Errors window and the Report window is displayed.
During the connection procedure, Release Builder will check for the presence of a
Knowledge Base for licensing requirements (see Knowledge Base connection for more
information). If no details of a Knowledge Base have been entered in the Create Profile
dialog box, then you will be prompted to enter a Local Key in the following dialog box:
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Connection Information

This key can be obtained by contacting CAST and quoting the machine ID displayed in the
above dialog box.
Please note that the machine ID required to create a CAST Local Key is generated
automatically by the application - however the generation process relies on the existence
of a C: drive on your workstation. If a C: drive does not exist on your workstation, the
application will be unable to generate the machine ID.
See Also
Launching Release Builder
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Knowledge Base connection

Knowledge Base connection
●

●

●

During the CAST server side installation process (if you are installing Release Builder as
part of a suite), you may be prompted to choose whether to install a CAST Knowledge
Base. If you choose to do so (and you will need to if you want to use the full range of
applications in the suite), this will enable you to analyze your server side projects and
store the results in the Knowledge Base.
A Knowledge Base may also be necessary for Release Builder licensing requirements check with your CAST contact.
The Knowledge Base is a standard schema/database created on an SQL server. You can
choose to install it on any server of your choice (i.e.: development server or on its own
dedicated server - see the Server Manager help for more information).

If you are using a Knowledge Base with Release Builder:
●

Wherever you choose to install the Knowledge Base in relation to the schemas/database
you want to work with using Release Builder, you will need to provide some connection
information so that Release Builder can "find" the Knowledge Base:
❍

❍

If the Knowledge Base is installed on the SAME server as the schemas/databases
you are working on (LOCAL), then you only need to specify the name of the
Knowledge Base (the database/schema name) in the Add/Edit Server Connection
Profile dialog box in the Knowledge Base name and the Knowledge Base
Profile name sections.
If the Knowledge Base is installed on a DEDICATED server (REMOTE):
- create a Connection Profile that specifies the Knowledge Base name (the
database/schema name) and the server on which it is installed.
- create a second Connection Profile that specifies the server on which the
schemas/database you want to work with are installed.
- in this second Profile, specify the name of the first Profile (the Profile that contains
the Knowledge Base connection parameters) in the Knowledge Base Profile name
section.
See Creating Connection Profiles.
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Info dialog box

Info dialog box
This dialog box displays various information regarding the different Connectivity Layers on
your workstation. It can be launched from:
●

By clicking Help > Connection Layer Information

These layers are used by CAST Products to connect to the various servers accessible from your
workstation.

Connectivity Layers found on your Local Machine
Server
See Also
Connection
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Connection Manager dialog box

Connection Manager dialog box
The Connection Manager dialog box displays details of any connections that are already open
to a server and enables you to use an existing connection or to open a new connection.
If you attempt to open a connection to a server and if a free connection is available, the
Connection Manager dialog box will appear (see below). Otherwise, the standard Open Profile
Connection dialog box will be launched.
A connection implies creation of a Report Document. This is used to log the session information.

OK

Enables you to choose a connection (if more than one is
available).

New

Clicking New will launch the Open Profile Connection dialog box.
Use this to select the server you want to establish a concurrent
connection with.

Close

This button closes the dialog box.

Notes
●

To close an existing connection, close the associated Report window.

See Also
Open Profile Connection dialog box | Connection | Report window
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Connection Profiles

Connection Profiles
●

What are Connection Profiles?

●

Creating Connection Profiles

●

Editing Connection Profiles

●

Removing Connection Profiles

●

Open Profile Connection dialog box
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Application Interface

Application Interface
●

Messages and Errors List

●

Report window

●

SQL Script window
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Messages and Errors List

Messages and Errors List
The Messages and Errors List will launch automatically when you first start the application. This window logs
any messages or error messages sent from the server or the application. This logging of messages can help
localize a problem very quickly. CAST can also use the log file to diagnose serious errors.

How does it work?
Each time a warning or an error (i.e. from the server) is received a new message is displayed in the Messages
and Errors List - in other words a new line will be created. For each message displayed in the list, information
will be provided via a variety of different columns.
The information displayed in the Messages and Errors List is stored in temporary files (*.tmp) on your hard
drive, on a "per-application" basis:
%TEMP%\CAST\CAST\<version_number>\logs
The contents of this folder is associated to each session created by each CAST application that has been
executed on the workstation by the specific user. You can delete the contents of this temporary folder if you
need to free up space on your hard disk, however, make sure that you kill all CAST applications before doing so.
Shortcut menu
Log File
See Also
Messages & Errors tab
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Report window

Report window
This is an editable window that logs all reports generated using Release Builder. Each time you
connect to a server (whether when launching the application or when opening a concurrent
connection) a new report window will be displayed to log actions made with the specific server
connection.
An asterisk (*) in the window title indicates that the contents have been modified, but NOT
saved. See below for more information on how to save the Report Window.

Please note that the messages contained in this example are for an Oracle server. Similar
messages will appear when using any other type of server.
Script Extraction, Database Comparison and BCP Reports
When you start a Script Extraction, Database Comparison or BCP Transfer process, the Report
Window will change titles and include a log of events that occurred during each extraction
performed through the associated connection. These reports can also be edited. See below for
information about saving the Report Windows.
Saving the Report Window
The contents of the Report Window can be edited and then saved (in ASCII text format) by
using the Save/Save As commands located in the File menu.
See Also
Script Extraction | Database Comparison | BCP Transfer
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SQL Script window

SQL Script window
The SQL Script Window will display files containing SQL statements opened in Release Builder.
You can visualize the content of the file (useful for checking SQL files automatically generated by
the Release Builder Script Extraction feature) and modify it if you want.
●

Clicking File > New SQL Script will also open this window enabling you to create a script.

●

Save/Save As features are provided through the File menu.

Example SQL file automatically generated by Release Builder:

See Also
Script Extraction
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Assistant

Assistant
When a server connection is established, the Assistant will be automatically displayed. It
enables you to select one of the main Release Builder features and work through the subsequent
wizard screens.

Common Features tab
Profile Features
Source Manager Features tab
Dependencies tab
Launching the Assistant
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Script Extraction Assistant

Script Extraction Assistant
●

What is a Script Extraction?

●

Launching a Script Extraction

●

Assistant Description dialog box

●

Step 1 - Extraction Source

●

Step 2 - Object Selection

●

Step 3 - Scripts Destination Files

●

Miscellaneous Script Extraction dialog boxes
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What is a Script Extraction?

What is a Script Extraction?
A Script Extraction is the process of building scripts that include create / drop statements for the
selected objects and then (if required) building a new release profile based on a selection of
objects (Release Profiles can be used for example in the Database/Schema Comparison
Assistant).
You can select a totality or a subset of elements from a database or from a release profile and
then extract the required script.
The Script Extraction process in Release Builder is carried out via a wizard (see Step 1 Extraction Source).
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Launching the Script Extraction Assistant

Launching the Script Extraction Assistant
To launch the Script Extraction Assistant, you can:
1. Select Script Extraction from the Release Builder Assistant
2. Or select Script Extraction from the SQL-Server menu
3. Or use the shortcut key, CTRL+R
4. Or click the

button located on the toolbar

In some cases the Connection Manager dialog box will then be displayed (particularly) after
carrying out other processes. Select a connection you want to use in this dialog box.
This will launch the Script Extraction Description Assistant, which will then take you to Step 1 Extraction Source Wizard
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Assistant Description dialog box

Assistant Description dialog box
When you launch any of the Wizard Assistants (see See Also at the bottom of this page) an
initial page will be launched that provides you with a brief description of what the assistant does.
This page is slightly different for each Wizard Assistant.

Never Display Again
Select this option if you don't want to display this page again. This option is also defined in the
General tab of the General Configuration dialog box.
See Also
Command Line Assistant | Database Comparison | Script Extraction Assistant | General tab
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Extraction Source Wizard

Step 1 - Extraction Source Wizard
This first step of the Extraction Assistant prompts you to select the source database/schema
or the release profile that you want to extract:

Live Database
Offline Profile
What to do next...?
Once satisfied with your selections, click <Back to move back to the Assistant Description dialog
box, click Next> to move on to the next step, or Cancel to abort the process.
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Object Selection Wizard

Step 2 - Object Selection Wizard
This step of the Extraction Assistant enables you to carry out the script extraction on a sub-set
of objects if you prefer, instead of an entire database:

The left hand column contains the database and all its object types which you have selected for
the Script Extraction process - if you want to change this, you can do so in Step 1. A single click
on an object type in the left hand column will display the objects in the right hand column
together with their name and the date when they were last modified.
If you want to select only one type of object, simply select the object type name in the left hand
column and the assistant will automatically select the associated objects in the right hand
column. Where a check box is shaded, this means that only some of the sub-objects have been
selected.
Consider/Match [XXXXX] Selection
When selected, this check box (available only when certain object types are selected), disables
the Object List and sets up the selection according to the selection made on the list of parent
objects (this enables you to get dependencies only for the objects you are interested in).
Note that when the server node is checked, the Consider/Match [XXXXX] Selection options
are not taken into account. Uncheck the server node, then check your object's selection to use
these options.
Main Editor Window
Notes
●

If you want to carry out the Script Extraction on ALL the objects in the selected Live
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Object Selection Wizard

Database or Offline Profile, ignore this step and move on without making any changes.
What to do next...?
Once satisfied with your selections, click <Back to move back to the Extraction Source Wizard,
click Next> to move on to the next step, or Cancel to abort the process.
See Also
Filter dialog box | Statistics dialog box | Scripts Destination Files Wizard
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Scripts Destination Files Wizard

Step 3 - Scripts Destination Files Wizard
This step of the Extraction Wizard enables you define the generated statement (whether
create/drop) and the destination of the extracted script. Other options can also be defined here.

Script Content
Create / Drop
Generated Files
Single / Multiple / Drop &
Create Files

Select any of these check boxes to generate scripts that
include create and/or drop statements for the selected
objects.
Use these options to specify whether the DDL statements
should placed in a single file, multiple files (one file for
each object type), or two files (one for create statements,
and one for drop statements).
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Scripts Destination Files Wizard

Output File / Base Directory/
Create File & Drop File

●

●

●

If the Single File option is specified, enter a file
name and location in the text box for the script
destination. Use the Browse button to select a new
location.
If the Multiple Files option is selected, specify a
directory where all the script files will be created. A
new button will appear (File Options) which
displays the Advanced File Options dialog box
where the name and location of each script file can
be specified (see File Options below). A check box
can also be selected (Create if doesn't exist)
which will create the directory if it does not already
exist.
If the Drop and Create Files option is selected,
specify file names and locations for the create and
drop script in the Create File and Drop File text
boxes respectively.

Extraction Options

Click this button to launch the Script Extractions tab.

Save Profile

Clicking this button will launch the Save Release Profile
dialog box enabling you to validate options used during
the profile creation process, to set parameters and save a
new Release Profile (dynamic or offline) based on the
current selection of objects and output options.

What to do next...?
Once satisfied with your selections, click <Back to move back to the previous step, click
Next> to move on to the next step, or Cancel to abort the process.
See Also
Advanced File Options dialog box | Script Extractions tab | Save Release Profile dialog box
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Miscellaneous Script Extraction dialog boxes

Miscellaneous Script Extraction dialog boxes
All the dialog boxes listed below can be accessed directly from the Script Extraction Wizard and
are relative only to that wizard.
●

Release Profile Details dialog box - accessible from Step 1

●

Filter dialog box - accessible from Step 2

●

Statistics dialog box - accessible from Step 2

●

Save Release Profile dialog box - accessible from Step 3

●

Advanced Options (Substitution Map) dialog box- accessible from the Save Release Profile
dialog box
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Release Profile Details dialog box

Release Profile Details dialog box
This dialog box, which is accessible from the Step 1 - Extraction Source Wizard, and from the
Profile Import Wizard, allows you to review the characteristics of a profile and to validate various
parameters before loading the release profile:

Profile Description
Load Options
See Also
Extraction Source Wizard
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Filter dialog box

Filter dialog box
This dialog box can be launched from the Object Selection Wizard of the Script Extraction
Assistant, by right clicking on an object or object type in the right hand column. It enables you
to filter the objects that will be taken into account during the Script Extraction process.

No Filter

When this check box is selected, no filter will be placed on
the objects or object types you selected before right
clicking to launch this dialog box. In other words, ALL the
objects will be taken into consideration during the Script
Extraction Process.

Last Modification Date Mask

Select this check box if you only want to take into account
only those objects modified between two dates that you
can define in the text boxes immediately below.

Name Mask

Select this option if you want to take into account only
those objects matching a regular expression. You can
enter the Regular Expression manually in the text box, or
you can click Insert Special Expression (which is
described in more detail below) and select what you
require.
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Filter dialog box

Insert Special Expression

Help Regular Expression

This option automatically inserts a Regular Expression in
the text box immediately above. You can select one of
four options (or combine the options in the text box).

●

Any Character will insert .+

●

Any Digit will insert [0-9]+

●

Any Letter will insert [a-zA-Z]+

●

Tab Character will insert a Tab Character

Click this button to launch the Regular Expressions help
page to find out more about Regular Expressions.

Click OK to return to the Object Selection Wizard and Cancel to abort the definition of a Filter.
Return to Step 2
Once you return to the Object Selection Wizard, if you have specified a Filter on a group of
objects or an object, a small red F sign will be displayed on the object or object type, as shown
below:
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Filter dialog box

See Also
Object Selection Wizard
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Statistics dialog box

Statistics dialog box
This dialog box can be launched from the Object Selection Wizard of the Script Extraction
Assistant, by right clicking on an object or object type in the right hand column. It displays
various statistics about the objects you have selected for the Script Extraction Process.

Total Number of Objects

This shows the total number of objects in the database/schema

Total Number of
Comments (or whatever
object you selected)

Displays the total number of objects of the same type in the
database/schema

Number of Selected
Objects

Displays the number of objects you have selected to be taken
into consideration during the Script Extraction Process

Number of Selected
Comments (or whatever
object you selected)

Displays the number of objects of the type that you have selected

Number of Filtered
Comments (or
whatever object you
selected)

This shows the total number of objects of the type that you have
selected that have a Filter on them.

Number of Hidden
Comments (or whatever
object you selected)

Displays the number of hidden objects of the type you have
selected

See Also
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Statistics dialog box

Filter dialog box
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Save Release Profile dialog box

Save Release Profile dialog box
This dialog box, which is accessible from the Scripts Destination Files Wizard, allows you to
specify the parameters to be used when creating a Release Profile from a Live Database.

File Name

This text box contains the full path used to create the release
profile on your PC. It is possible to use the browse button to
locate the path and file you require rather than typing it
manually.

Store Object Selection

Select this option if you want your Release Profile to include ALL
the objects in the selected database/schema. This is the default
option.
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Save Release Profile dialog box

Retrieve and Store
Object Definitions

Activate this check box to include the Object Definitions in the
saved profile. In addition, checking or leaving this dialog box
blank determines whether your profile will be saved as Offline or
as Dynamic.
- Offline
The Offline profile is a full backup (database object definitions
ONLY) of a database. It can or cannot contain filters. In other
words, when using offline profiles, you do not need to have
access to the physical database in order to carry out a
comparison or script extraction.
- Dynamic
The Dynamic profile does not contain object definitions. It
contains only settings such as filters or object selection you select
in the wizard and that you want to save (so the next time you
don't have to re-write the regular expressions or re-select the
objects you are interested in). In order to use a dynamic profile
you must be connected to a server that contains a database that
the profile refers to.

Store File and Directory
names

Activate this check box to include the File Options in the saved
profile.

Profile Date (from
Server)

The creation date of the profile is automatically retrieved from the
server (not from your local PC) and saved as part of the profile
header. Before loading a profile, you then have the possibility of
checking when it was created.

Profile Content

This multi-line edit control lets you enter a description associated
with the profile. Before loading a profile, this brief description will
give you an idea what the profile does.

Save

Use the Save button to store the Profile in your chosen location.

Cancel

This button closes the dialog box without creating the profile.
Note that most of the parameters you set in this window remain
active if you want to build the profile at a later date (from the
same Release Builder session).

See Also
Scripts Destination Files Wizard
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Database Comparison Assistant

Database Comparison Assistant
●

What is the Database Comparison Assistant?

●

Launching the Database Comparison Wizard

●

Assistant Description dialog box

●

Step 1 - Out of Date Database Wizard

●

Step 2 - Up to Date Database Wizard

●

Step 3 - Comparison Output Options Wizard

●

Step 4 - Delta Script Options Wizard

●

Miscellaneous Database Comparison dialog boxes
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What is the Database Comparison Assistant?

What is the Database Comparison Assistant?
The Database Comparison Assistant enables you to compare two databases (one up to date, the
other not) and then automatically generate the necessary scripts to upgrade the out-of-date
database.
The feature is wizard based.
See Also
Out of Date Database Wizard | Up to Date Database Wizard | Comparison Output Options Wizard
| Delta Script Options Wizard
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Launching the Database Comparison Assistant

Launching the Database Comparison Assistant
To launch the Database Comparison Assistant, you can:
●

Select Database Comparison... from the Release Builder Assistant

●

Select Database Compare from the SQLServer menu

●

Use the shortcut key, CTRL+D

●

Or click the

button located on the toolbar

In some cases the Connection Manager dialog box will then be displayed (particularly) after
carrying out other processes. Select a connection you want to use in this dialog box.
The Database Comparison Description Assistant will then be displayed, prior to Step 1 - Out of
date Database.
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Out of Date Database Wizard

Step 1 - Out of Date Database Wizard
The first step in the Database Comparison Assistant enables you to choose the out of date
database that will form part of the comparison process.
You can select either of the following as the source:
●

●

a live database (establishing a connection to the specified server)
or an offline profile (if you want the source elements in the comparison process to be
taken from a release profile)

Live Database

Select this option if you want the comparison source elements to
stored in an existing database. The server name will be the same
server that you are currently connected to, however, you can
change this by clicking the browse button which will launch the
Connection Manager dialog box.
You can select the out of date database in the drop down list
below. This will contain a list of all the databases stored on the
server.

Offline Profile

Select this option if you want the comparison source elements to
be stored in a release profile. When you select the option, a
standard Windows Open dialog box will be launched enabling
you to select the profile you require.
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Out of Date Database Wizard

What to do next...?
Once satisfied with your selections, click Back to move back to the Assistant Description dialog
box, click Next to move on to the next step, or Cancel to abort the process.
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Up to Date Database Wizard

Step 2 - Up to Date Database Wizard
The second step in the Database Comparison Assistant enables you to select the up to date
database to compare with the out of date database selected in Step 1.
As with Step 1, you can select either of the following as the source:
●

●

a live database (establishing a connection to the specified server)
or an offline profile (if you want the source elements in the comparison process to be
taken from a release profile)

What to do next...?
Once satisfied with your selections, click Back to move back to the previous step, click Next to
move on to the next step, or Cancel to abort the process.
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Comparison Output Options Wizard

Step 3 - Comparison Output Options Wizard
The third step in the Database Comparison Assistant enables you to define the type of
document you want the assistant to generate at the end of the comparison process.
This dialog box can be accessed from the Up to Date Database Wizard.

Generate HTML Report
(HTML Report Options)

This button will launch a separate dialog box enabling you to
specify the name of the HTML report generated by the
comparison process. You can use the file selector button in his
dialog box to select a directory and HTML file to be used for the
report.
For more information, see HTML Report Options.

Generate the Delta
Scripts

Select this check box if you want the Comparison Assistant to
automatically generate update scripts for your out of date
database. When you select the option, the Compare button (at
the bottom of the dialog box) will change to Next> and a fourth
step in the wizard can be accessed.
For more information, see the Delta Script Options Wizard.
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Comparison Output Options Wizard

Knowledge Base
Handling

This button will launch a separate dialog box enabling you to
create a file that can be used in Analysis Manager to synchronize
all the objects that have been modified in the generated script.
For more information, see the Knowledge Base Handling Options
dialog box.

Comparison Options

This button provides direct access to the Compare Options dialog
box to let you specify comparison options before launching the
comparison process.

BCP/Release Profiles

This button provides direct access to the BCP/Release Profiles
dialog box enabling you to specify that the results of your
Database Comparison be displayed as either a BCP or Release
Profile.

What to do next...?
Once satisfied with your selections, click <Back to move back to the previous step, click
Next> to move on to the next step (only if you have selected the Generate Delta Scripts
option), Compare to begin the comparison process, or Cancel to abort the process.
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Delta Script Options Wizard

Step 4 - Delta Script Options Wizard
The fourth step in the Database Comparison Assistant enables you to define the contents and
structure of the delta script (should you choose to generate a script).

Generated Statements
Script Structure
Notes
●

Please note that this wizard is only accessible if you have selected the Generate the
Delta Scripts option in the Comparison Output Options Wizard.

What to do next...?
Once satisfied with your selections, click <Back to move back to the previous step, click
Compare to begin the comparison process, or Cancel to abort the process.
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Miscellaneous Database Comparison dialog boxes

Miscellaneous Database Comparison dialog boxes
All the dialog boxes listed below can be accessed directly from the Database Comparison Wizard
and are relative only to that wizard.
●

HTML Report Options dialog box - accessible from Step 3

●

Knowledge Handling Options dialog box - accessible from Step 3

●

Compare Options - accessible from Step 3

●

BCP/Release Profiles - accessible from Step 3

●

Column Assignment - Change Identification dialog box

●

Object Dependencies dialog box

●

Confirm Script Contents dialog box
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HTML Report Options dialog box

HTML Report Options dialog box
This dialog box (accessible from the Comparison Output Options Wizard) enables you to specify
the name of the HTML report generated by the comparison process.

Generate HTML Report

Select this check box if you want to generate an HTML Report
when the Database Comparison Process is completed.

Destination File

Select the location for your HTML Report in this field. A
destination will automatically be selected for you, but you can
change this if you want by clicking the Browse button.

Style Sheet

If you want to use a particular style sheet for the generation of
the HTML Report, you can specify its path here.
A default style sheet will be used in all other cases.

Notes
●

The HTML report will be generated when you launch the comparison process.
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Knowledge Handling Options dialog box

Knowledge Base Handling Options dialog box
This dialog box (accessible from the Comparison Output Options Wizard) enables you to specify
whether you want Release Builder to generate a Synchronization File (.TXT file) for the
Database Comparison Process and define the location for such a file.
A synchronization text file can then be used in CAST Analysis Manager via the command line. All
objects listed in the text file will be synchronized.

Generate
Synchronization
File

Select this option if you want Release Builder to create a file that can
then be used in CAST Analysis Manager to automatically
synchronize all the objects that have been modified in the generated
script.

Destination File

Generate Fine Grain Impact Analysis

Select the location for the Synchronization
File in this field. A destination will
automatically be selected for you, but you can
change this if you want by clicking the
Browse button.
Not available

Click OK when you are satisfied with your selections. The dialog box will then close.
Notes
●

●

The synchronization text file will be generated when you launch the comparison process.
If there are no differences found during the comparison process, no synchronization file
will be generated.
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Knowledge Handling Options dialog box
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Compare Options dialog box

Compare Options dialog box
This dialog box, which is accessible from the Comparison Output Options Wizard, enables you to
specify various options for the comparison process. These options will then be stored in a
template so that you can reuse them in subsequent sessions (for example in the Command Line
Assistant). You can create as many templates as you require (this can be done in the Database
Compare tab and each template can contain a variety of different options.
This dialog box is virtually identical to the Database Comparison tab located in Options >
Database Compare... on the menu bar.

Template
Comparison Scope
Object Comparison based On
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Compare Options dialog box

Table Data Handling
Text Object Comparison
Consider
Miscellaneous
See Also
Comparison Output Options Wizard | Database Comparison tab | Advanced Options dialog box |
Confirm Script Contents dialog box
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BCP/Release Profile dialog box

BCP/Release Profile dialog box
This dialog box (accessible from the Comparison Output Options Wizard, enables you to specify a
BCP Profile or Release Profile Generation prior to the Comparison Output.

Save BCP Export Profile

Select this option if you want the Comparison Assistant to
generate a BCP profile in order to restore data contained in tables
that you have dropped and re-created (this script must be
executed before running the upgrade script generated by the
Database Comparison Assistant).

Save BCP Import Profile

Select this option if you want the Comparison Assistant to
generate a BCP profile in order to restore data contained in tables
that you have re-created.
Use the Browse button to specify the location.

Save Drop Statement
Profile

Select this option if you want the Comparison Assistant to
generate a Release Profile containing all the objects affected by
Drop statements
Use the Browse button to specify the location.
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BCP/Release Profile dialog box

Save Create Statement
Profile

Select this option if you want the Comparison Assistant to
generate a release profile containing all the objects affected by
Create statements.
Use the Browse button to specify the location.

Notes
●

The profiles will be generated when you launch the comparison process.
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Column Assignment / Change Identification dialog box

Column Assignment / Change Identification dialog box
This dialog box appears during the Database Comparison process when a change has been detected on a table
(and if the object comparison is based on structure - see the Database Comparison tab for more information).
It allows you to check the validity of the detected change and also to review the assignment between the
previous and current table columns.

Table

Shows the name of the table whose structure has been altered in the
current database.

New Table structure:
Column / Data Type /
Change / Assignment

Shows the structure of the table from the out of date database along with
the detected change(s) and the assignment with the previously existing
columns (see Previous Table Structure).

Previous Table Structure:
Column / Data Type /
Change

Shows the structure of the table from the Reference Database.

Assign to Expression

Click this button to assign the selected column(s) with a constant value or
an expression depending on the previous table columns.

Expression Value

Enter a constant value or an expression depending on the previous table
columns to be assigned with the selected columns, here.

Assign to Column

Click this button to assign the selected column(s) of the new table
structure with the selected column of the previous table structure.

Assign to Null

This button allows you to assign a column with a NULL value (note that the
chosen column must have the null attribute).

Restore Defaults

Click this button to restore the default assignment of the columns.

Resume the Comparison
Process!

Validates the chosen parameters and closes the dialog box.
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Column Assignment / Change Identification dialog box
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Object Dependencies dialog box

Object Dependencies dialog box
This dialog box appears when using a Drop and Create Script Generation when the objects to
be deleted have unselected dependent objects.
This dialog box prompts you to select these dependent objects in order to recreate them when
you run the generated script.

Object Type / Object
Name

List of unselected dependent objects.

Add the dependent
objects to the create
script

Select this option if you want to select the listed dependent
objects during the script extraction.
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Object Dependencies dialog box

Don't change
anything...

Select this option if you do not want to select listed dependent
objects during the script extraction. If you run the generated
script, the listed dependent objects will be lost permanently.

Description

A description can be entered to comment on the profile when it
has been created.

Load Options / Full
Object Definitions
(Offline Profile)

This option is disabled if the profile you selected is of type
Dynamic. If it is of type Offline, you can choose this option if you
want to load it as an offline profile (it is always possible to load
an Offline profile as a Dynamic profile (see option below).

Load Options / Only
Objects Selection and
Filters (Dynamic
Profile)

This option is always enabled. Whether the profile you selected is
of type Offline or Dynamic, you can load it as a dynamic profile
against the database currently selected in the Source Database /
Live Database combo box of the Database Script Extraction and
Release Profile Management dialog box.
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Confirm Script Contents dialog box

Confirm Script Contents dialog box
The Confirm Scripts Content dialog box enables you to choose which objects will be included in
the update script generated by the Database Comparison Assistant (if you have chosen to
generate it - see the Comparison Output Options Wizard).
By default, this dialog box is NOT displayed and all objects that need creating, updating or
changing following the database comparison process will be automatically included in the update
script.
To force this dialog box to be displayed during the database comparison process you need to
select the Confirm script contents option (this is cleared by default) from either:
●

the Database Compare tab

●

or the Compare Options dialog box

When the dialog box is first displayed, all objects that need creating, updating or changing
following the database comparison process will be highlighted (blue colour). If you are satisfied
that all displayed objects can be included in the update script, click the OK button to generate it.
If, however, you want to exclude some specific objects from the update script, select them in the
dialog box. They will no longer be highlighted (white background as above). When satisfied, click
OK to starte the update script generation.
Notes
●

If you select the Confirm script contents option this disloag box will always be
displayed, regardless of whether you have chosen to generate an update script - see the
Comparison Output Options Wizard.
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Confirm Script Contents dialog box
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Command Line Assistant

Command Line Assistant
The assistant contains various dialog boxes depending on the type of process you want to carry
out:
●

What is the Command Line Assistant?

●

Launching the Command Line Assistant

●

Assistant Description dialog box

●

Selection - choose the type of batch you require: Extraction, Delta, Bulk Copy or Build
Profile

Extraction
●

Connection

●

Select Profile (only if Script Extraction for Whole Server option is ignored)

●

Select Profile Directory (only if Script Extraction for Whole Server option is selected)

●

Select Delta Comparison Template Name

●

Select Files

●

Batch File Name Selection

Delta (Database Comparison)
●

Connection

●

Select Source Database/Profile

●

Select Reference Database/Profile

●

Select Delta Script Files

●

Select Delta Comparison Template Name

●

Select Files

●

Batch File Name Selection

Bulk Copy
●

Connection

●

Select Profile

●

Select Files

●

Batch File Name Selection

Build Profile
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Command Line Assistant

●

Connection

●

Select Profile (only if Script Extraction for Whole Server option is ignored)

●

Select Profile Directory (only if Script Extraction for Whole Server option is selected)

●

Select Extraction Script Name

●

Select Delta Comparison Template Name

●

Select Files

●

Batch File Name Selection
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What is the Command Line Assistant?

What is the Command Line Assistant?
The Command Line Assistant enables you to build a batch script you can execute to perform
actions with Release Builder. This batch script contains command lines you can edit and run
yourself.
You can:
●

Extract profiles

●

Compare a release profile and a schema (delta)

●

Perform a BCP transfer

●

Build a release profile

For example, if you choose to build a batch script that will create a release profile with the
command line assistant, the resulting .BAT file may look something like this:

"C:\CAST\builds\SQL-Server\relbuild.exe"
-CONNECT(BERTIE,sa) -BUILDRPF(CASTPubs,"CASTPubs.rpf","C:\CASTPubs.sql","",TRUE)
-LOG("C:\report.txt","C:\message.txt")
You can get more information about the command lines that are inserted into the batch script
here.

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/RELBLD/Features/CommandLine/what.htm [10/07/2008 11:47:30]

Launching the Command Line Assistant

Launching the Command Line Assistant
To launch the Command Line Assistant, you can:
●

Select Command Line Assistant from the Release Builder Assistant

●

Select Command Line Assistant from the Tools menu

●

Use the shortcut key, CTRL+H

●

Or click the

button located on the toolbar

In some cases the Connection Manager dialog box will then be displayed (particularly) after
carrying out other processes. Select a connection you want to use in this dialog box.
The Command Line Description Assistant will then be displayed, prior to Command Line Initial
Selection.
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Command Line Initial Selection

Command Line Initial Selection
This first step of the Command Line Assistant asks you to choose the type of action you want
the generated batch file to perform.

Extraction Command
Line

Select this option if you want the assistant to generate a batch
file that performs an extraction.

Delta Command Line

Select this option if you want the assistant to generate a batch
file that performs a database comparison.

Bulk Copy Command
Line

Select this option if you want the assistant to create a batch file
that performs a Bulk Copy (BCP transfer).

Build Profile Command
Line

Select this option if you want the assistant to create a batch file
that creates a release profile.
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Command Line Initial Selection

Save reports into Logs
Files

Select this option if you want to save the report document and
the message window at the end of the extraction or comparison
process. Selecting the option will cause the Select Files dialog box
to be displayed as part of the wizard enabling you to select the
location of the files that you want to save.
If you don't use this option, the application will remain open after
the command line has completed to enable you to view errors
and messages. The Select Files dialog box will be skipped.

Don't save reports

Select this option if you do not want to save the resulting reports.
The Select Files dialog box will be skipped.

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
See Also
Command Line Connection (for all options)
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Batch File Name Selection (for all options)

Batch File Name Selection (for all options)
This step of the Command Line Assistant shows you the generated command line, and
prompts you for a batch file in which to save this command line.

Add the instruction at
the end of the file

Select this option to append the new generated command line to
the selected file without overwriting it.

Overwrite file

Select this option to overwrite the selected file with the generated
command line.

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Finish to
close the dialog box or Cancel to abort the process.
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Command Line Connection (for all options)

Command Line Connection (for all options)
This next step of the Command Line Assistant prompts you to enter the connection
parameters that will connect you to the server on which you want to perform the chosen action
(the connection parameters will be included in the batch file).

Open Connection with the Last
Parameters

Select this option if you want to use the connection
parameters entered for the most recent server connection
process.
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Command Line Connection (for all options)

Open with the
Following
Parameters

Open with
profile

Server / User
Name
/Password
/Knowledge
Base Name/
Knowledge
Base Server /
Knowledge
Base User /
Knowledge
Base
Password
Profile

Database (for Build Profile option
only)
Script Extraction for Whole
Server (for Script Extraction
and Build Profile option only)

Select this option if you want to define new connection
parameters. Enter the connection parameters that
correspond to the server you want to connect to.
See the Add/Edit Connection Profiles dialog box for more
information about these options.

Select the Connection Profile from the drop down box. You
can alter the Connection Profiles in the Open Profile
Connection dialog box.
Select the database you want the profile to reflect.
Select this option if you want the selected process to be
applied to the entire server.
●

●

Script Extraction > If you select this option,
instead of being able to choose a specific Release
Profile for the Extraction process, you will only be
able to select a folder - all Release Profiles in that
folder will then be included in the batch file.
Build Profile > If you select this option, instead of
creating one Release Profile for the selected
database, Release Profiles will be created for all
databases stored on the selected server. You can
select a folder in which the Release Profiles will be
stored.

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Delta Script Files (for Delta option)

Select Delta Script Files (for Delta option)
This step of the Command Line Assistant asks you to select the delta script files in which the
drop and create statements will be saved. Use the Browse button to select an existing file if
necessary.

Option buttons
Selecting or clearing one of the option buttons will enable you to configure the type of file(s) you
want to create. You can create one file (an output file) containing both script types, or one file for
each type of script.
What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Delta Comparison Template Name (for Script Extraction, Delta and Build Profile options)

Select Delta Comparison Template Name (for Script Extraction, Delta
and Build Profile options)
●

●

●

If the associated action with the current command line is a Script Extraction, this step of
the Command Line Assistant asks you to select a template - the template's associated
substitution map will be applied to the body of all objects retrieved from the server.
If the associated action with the current command line is the Delta, this step of the
Command Line Assistant asks you to select a delta comparison template - this template
will then be used during the comparison process
If the associated action with the current command line is a Build Profile, this step of the
Command Line Assistant asks you to select a template - the template's associated
substitution map will be applied to the profile to be generated.

The dialog box above is for a Delta process. The dialog box for the Build Profile differs only very
slightly. If you are creating a Script Extraction batch file, the dialog box will allow you to select
different comparison templates (with their associated substitution maps) for each Release Profile
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Select Delta Comparison Template Name (for Script Extraction, Delta and Build Profile options)

you are extracting:

Regardless of the process, select the Template you require from the drop down list box (a
description of the selected template will be displayed in the read-only text box).
If carrying out a Script Extraction process make sure you apply the correct template to each
Release Profile.
What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Profile (for Script Extraction and Bulk Copy options)

Select Profile (for Script Extraction and Bulk Copy options)
●

●

If the associated action with the current command line is a Script Extraction, this step of
the Command Line Assistant prompts you to select the release profiles (.RPF) you
want to extract when you run your batch file.
If the associated action with the current command line is a Bulk Copy, this step of the
Command Line Assistant asks you to select profiles (.BPF) you want to Bulk Copy
when you will run your batch file.

Notes
●

●

The dialog box below is for an Extraction. The dialog box for the Bulk Copy differs only
very slightly.
In some cases, you may be asked to select a specific folder that contains the release
profiles (.RPF) you want to extract when you run your batch file. See Select Profile
Directory (for Script Extraction and Build Profile options)
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Select Profile (for Script Extraction and Bulk Copy options)

1. Click Add to include a new Release Profile (.RPF file) or a BCP Profile (.BPF) in the list (you
can select more than one).
2. Delete will remove the selected profile from the list.
What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Source Database/Profile (for Delta option)

Select Source Database/Profile (for Delta option)
This dialog box enables you to select the live database or the offline profile that will form the
source for the comparison process.

Live Database

Select the database from the drop down list (all databases stored
on the server you are connected to)

Offline Profile

Select the profile that you want to use as the source for your
comparison. Click the Browse button to search for the file (.RPF)
you require.

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Source Database/Profile (for Delta option)
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Select Profile (for Build Profile option)

Select Profile (for Build Profile option)
This step of the Command Line Assistant asks you to select the name or location (of an
existing profile) for the destination release profile - as shown in the image below.
Notes
●

In some cases, you may be asked to select a specific folder that contains the release
profiles (.RPF) for the destination release profile. This is true if you have selected the
Script Extraction for Whole Server option in Command Line Connection (for all
options).

Generate Live Profile
Selecting this option will force Release Builder to generate a Live Profile as oppose to an
Offline Profile.
When extracted, Live Profiles need to connect to the server to gather the requisite information.
Offline profiles can be extracted without the need for a server connection as the necessary
information has already been accessed.
file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/RELBLD/Features/CommandLine/cmdlineprof3.htm (1 of 2) [10/07/2008 11:48:33]

Select Profile (for Build Profile option)

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Profile Directory (for Script Extraction and Build Profile options)

Select Profile Directory (for Script Extraction and Build Profile
options)
This dialog box is only displayed if the Script Extraction for Whole Server option is selected in the
Command Line Connection dialog box.
●

●

For a Script Extraction process, it enables you to select a directory that contains all
relevant Release Profiles (.RPF) that will be extracted when the batch file is run.
For a Build Profile process, it enables you to select the destination directory for all the
Release Profiles (.RPF) that will be generated (a Release Profile will be generated for all
databases stored on the current server).

1. Click Browse to select a new directory in which the Release Profiles will be stored when
the batch file is run.
Generate Live Profile (Build Profile option only)
Selecting this option will force Release Builder to generate a Live Profile as oppose to an
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Select Profile Directory (for Script Extraction and Build Profile options)

Offline Profile.
When extracted, Live Profiles need to connect to the server to gather the requisite information.
Offline profiles can be extracted without the need for a server connection as the necessary
information has already been accessed.
What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Extraction Script Name (for Build Profile option)

Select Extraction Script Name (for Build Profile option)
This step of the Command Line Assistant asks you to select the extraction script name for
the generated profile. Click the Browse button to select an existing file.

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Files (for all options)

Select Files (for all options)
This step of the Command Line Assistant prompts you for various file locations to save the
report documents and message windows.
The display or otherwise of this dialog box depends on the options selected in the Command Line
Initial Selection dialog box.

Report File

Select the file location to save the report document generated by
the extraction or bulk copy.
In some cases, you may be asked to select a specific folder for
each report file. This is true if you have selected the Script
Extraction for Whole Server option in Command Line
Connection (for all options).
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Select Files (for all options)

Message File

Select the file location to save the contents of the message
window generated by the extraction or bulk copy.
In some cases, you may be asked to select a specific folder for
each message window file. This is true if you have selected the
Script Extraction for Whole Server option in Command Line
Connection (for all options).

HTML Report
Please note this section is only available when the Delta Command Line option has been
selected.
Destination

This option enables you to choose a destination file for the HTML
report that will be generated on completion of the
database/schema comparison process.

Style Sheet

This option enables you to choose a destination file for the style
sheet that will be generated on completion of the
database/schema comparison process.

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Reference Database/Profile (for Delta option)

Select Reference Database/Profile (for Delta option)
This dialog box enables you to select the live database or the offline profile that will form the
reference for the comparison process.

Live Database

Select the database from the drop down list (all databases stored
on the server you are connected to)

Offline Profile

Select the profile that you want to use as the reference for your
comparison. Click the Browse button to search for the file (.RPF)
you require.

What to do next...
Once satisfied with your selections, click <Back to return to the previous step, click Next> to
move on to the next step or Cancel to abort the process.
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Select Reference Database/Profile (for Delta option)
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BCP Transfer/Bulk Copy

BCP Transfer/Bulk Copy
●

What is the BCP Transfer/Bulk Copy?

●

Launching the BCP Data Transfer dialog box

●

Assistant Description dialog box

●

BCP Data Transfer dialog box

●

BCP Jobs Creation dialog box

●

Filter dialog box

●

Mask dialog box

●

BCP Job Properties dialog box

●

Text BCP Options dialog box

●

Native BCP Options dialog box

●

Column Assignment Value dialog box

●

Current BCP Profile dialog box

●

BCP Profile Details dialog box

●

In Progress dialog box

●

Job Reordering dialog box
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What is the BCP Transfer/Bulk Copy?

What is the BCP Transfer/Bulk Copy?
A BCP Transfer or Bulk Copy job enables you to transfer data from a table to a file (known as
BCP out) and from a file to a table (BCP in).
SQL-Server offers two BCP formats: text and native
●

●

A BCP in text mode enables you to transfer data from the table to a file in a readable
format that can be modified by any user.
A BCP in native mode transfers the data in an "internal" mode that is not readable by
users. This mode is quicker and more exhaustive than the text mode.

Release Builder also offers a "character" mode that simulates a BCP Transfer in text mode.
During this transfer, a SELECT query is carried out on the table and the results are then
transferred to a file (BCP out). During a BCP in, an INSERT statement is carried out on each line
of the file, which is then placed in the table. This mode is much slower than either text or native
BCP Transfers.
Example of use
A user wants to transfer the data from several tables of one particular database (the
development database for example) to other identical tables in another database (the production
database for example).
These two databases are not necessarily on the same server. The quickest way to carry out this
transfer is to follow the steps described below - all possible using Release Builder.
●

●

●

●

create a BCP out job for each table in the development database
execute these jobs, a group of files will then be created containing the data from each
table
create a BCP in job between each of the files you have just created and each of the
destination tables on the production server
execute these jobs; the data will be transferred quickly

To start a BCP Transfer, please refer to the BCP Data Transfer dialog box which explains how to
launch the process.
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Launching the BCP Transfer/Bulk Copy

Launching the BCP Transfer/Bulk Copy
To launch the BCP Transfer/Bulk Copy, you can:
●

Select Bulk Copy from the Release Builder Assistant

●

Select BCP Transfer from the SQLServer menu

●

Use the shortcut key, CTRL+B

●

Or click the

button located on the toolbar

This will launch the BCP Data Transfer dialog box dialog box:
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BCP Data Transfer dialog box

BCP Data Transfer dialog box
This dialog box enables you to set up the BCP Job List, manage your BCP Profiles, and begin
BCP Process execution.

Add Jobs

Click this button to add jobs to the Job List. The BCP Job Creation
dialog box will then be launched enabling you to define the jobs.

Up/Down

Click this button to move the current Job either Up or Down to
define the order in which jobs are carried out.

Duplicate

Click this button to duplicate the selected jobs. The new jobs will
be added at the end of the Job List.

Disable/Enable

Click this button to disable or enable the selected jobs. A plus or
minus sign displayed at the left-hand side of the Job List shows
the job status. Disabled jobs will be skipped during the execution
process.

Delete...

Click this button to remove the selected jobs. A small dialog box
prompts you for confirmation.
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BCP Data Transfer dialog box

Reorder...

Click this button to reorder the selected jobs according to
referential integrity information as found on the database. This
feature is useful when table constraints are used to prevent any
data inconsistency.
See Job Reordering dialog box for more information.

BCP Options...

This button is used to define options for the current Job via the
Native BCP Option dialog box or the Text BCP Option dialog box
(depending on the current Job type).

Column Assignment...

This button is used to define assignments between columns and
fields via the Column Assignment dialog box (only available if the
current Job format is Text).

Properties...

Click this button to see/edit details about the selected jobs in the
Job Properties dialog box (you can also double-click a job in the
list).

Load...

Click this button to replace the current Job List by loading an
existing BCP Profile (.BPF file). A Standard File Browser dialog
box will be displayed so you can select the file to load.

Save...

Click this button to set the parameters and save the current BCP
Profile by opening the Current BCP Profile dialog box.

Description

Displays the description of the current BCP Profile (set in the
Current BCP Profile dialog box). If no profile is currently defined,
<none> is displayed.

Start Data Transfer!

Click this button - once you have created the BCP Job List (or
loaded an existing profile) - to start the BCP Process. Only
enabled jobs will be started. The current dialog box will be closed
and the In Progress dialog box will display the progress
information.

Close

Click this button to close the dialog box. All updated parameters
are preserved and stored in the associated Report Document
context.

Notes
●

Due to technical limitations, the non-logged bcp modes (character and sql-text) do not
support the insertion of identity values. When importing data with these modes, the values
of identity columns are always determined by the SQL Server.
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BCP Job Creation dialog box

BCP Job Creation dialog box
This dialog box (which can be launched by clicking the Add Jobs button located in the BCP Data
Transfer dialog box) enables you to select and create jobs to be added to the Job List in the BCP
Data Transfer dialog box.

Database (left hand
column)

In this drop down list box, select the name of the Database used
to retrieve the Table List. After the selection of a new database, it
may take a few seconds to retrieve the new table list and row
counts (based on the Calculate Row Count... option of the BCP
Transfer tab).

Extract from Release
Profile

This button allows you to select a Release Profile (.RPF) which
contains a list of tables (but may also contains any other type of
objects) and load this list into the current table list. This feature is
generally used to backup the data of the tables involved in a
particular profile.

Filter...

This button displays the Filter dialog box. This dialog box is used
to define a specific filter applied when retrieving the list of tables.

Tables (name, row
count)

Displays the table list retrieved from the current database using
any currently defined filter. If some row counts are not calculated
(? sign), select the tables concerned to obtain their row count. A
double-click on any table re-calculates its row count.
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BCP Job Creation dialog box

Directory (right hand
column)

Specify here (using the Browse button) the directory to which the
data files will be exported and also from which they will be
imported.

Browse...

Use this button to display a Directory Browser to select a base
directory for data files.

Mask...

This button displays the Mask dialog box used to define a specific
mask for file list retrieval.

Files (name, byte size)

Displays the file list retrieved from the current directory with the
current mask. The <end> statement (at the beginning of the list)
must be selected to create an Export Job with a new target file.

Create Export Jobs...

Once you have selected a source table (containing data) and a
target file (or the <new> statement), click this button to create a
new BCP Export Job. The job is created with the Default Format
option (specified in the BCP Transfer tab).

Match Files

Click this button to find the matching file names according to the
selected tables (or all tables if none selected). You can then click
one of the Create buttons to create jobs.

Create Import Jobs...

Once you have selected a target table and source file (containing
data), click this button to create a new BCP Import Job. The job is
created with the Default Format option (specified in the BCP
Transfer tab).

Match Tables

Click this button to find the matching table names according to the
selected files (or all files if none selected). You may then click one
of the buttons to create jobs (see above).

Close

Click this button to return to the BCP Data Transfer dialog box.

See Also
BCP Data Transfer dialog box
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Filter dialog box

Filter dialog box
This dialog box, (which can be launched by clicking the Filter button in the BCP Job Creation
dialog box) lets you define a filter (based on date, owner or name) that will be used to retrieve
and build the table list.

No Filter

If you select this check box, every user table will be extracted
directly from the System Catalog instead of using a Filter. Clear
the check box (by selecting any of the other options) if you want
to use the Filter.

Creation Date Mask

Select this check box to define a date range mask via the two edit
boxes. The default dates are (respectively) the creation date of
the current database and the current SQL Server date.

Owner Mask

Select this check box to define a mask based on the table owner.
The drop down list box lets you select a specific owner from those
that exist in the database.

Name Mask

Select this check box to specify (through the associated edit box)
a mask based on the table names. Enter a string as if you were
entering a LIKE clause - for example: abc% will retrieve any
object whose name begins with abc.

OK

Click this button to validate your parameters and return to the
BCP Job Creation dialog box.

Cancel

Click this button to cancel any changes in the current dialog box
and return to the BCP Job Creation dialog box.

See Also
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BCP Job Creation dialog box
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Mask dialog box

Mask dialog box
This dialog box (which can be launched by clicking the Mask button in the BCP Job Creation
dialog box) lets you define a specific mask for the file list display.

Name mask

Enter a mask for the file names by using wildcard characters
(*?); for example: *.dat. Note that you can use semicolons to
specify multiple masks. Alternatively, select one of the predefined
options from the drop down list box.

Last Save Date Mask

Select this check box to apply a date mask (based on the last
time the file was saved).

Show Hidden files

Select this check box to display Hidden files with normal files.

Show System files

Select this check box to display System files with normal files.

OK

Click this button to validate your parameters and return to the
BCP Job Creation dialog box.

Cancel

Click this button to cancel any changes in the current dialog box
and return to the BCP Job Creation dialog box.

See Also
BCP Job Creation dialog box
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BCP Job Properties dialog box
This dialog box, (launched automatically from the BCP Job Creation dialog box or by clicking
Properties in the BCP Data Transfer dialog box) gives you details about the current BCP job. It
also lets you change the general options of this Job.

Direction (Export /
Import)

Displays and lets you modify the direction of the current BCP Job.
You may not be able to change this option if the source or target
item contains no data.

Enabled for Execution

Select this check box to disable or enable the current jobs.
Disabled jobs will be skipped during the execution process.

Overwrite Target File

When selected, this check box (available only for Export Jobs) will
clear the target file before executing the current jobs.

Truncate Table (with
Prompt)

When checked, this check box (available only for Import Jobs),
will clear the target table before executing the current jobs.

Format (Native Mode /
Character Mode / SQLText Mode)

Select the BCP Job format here (the Default Format is specified in
the BCP Transfer tab).

Database / Table

Displays the source/target table and origin database for the
current Job.
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BCP Job Properties dialog box

Directory / Data File

Displays the source/target file and origin directory for the current
Job.

OK

Click this button to validate your parameters and return to the
BCP Job Creation dialog box.

Apply All

An Apply All button may sometimes appear when launched from
the BCP Job Creation dialog box. This enables you to accept all
Jobs without having to check each individual job.

Cancel

Click this button to cancel any change in the current dialog box
and return to the BCP Job Creation dialog box.

See Also
BCP Job Creation dialog box
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Text BCP Options dialog box

Text BCP Options dialog box
This dialog box, which can be launched by clicking BCP Options in the BCP Data Transfer dialog
box, when the current BCP Job mode is SQL-Text or Character, lets you set several parameters
concerning this Job's execution.

First & Last Row

Specifies the starting and ending number of the rows taken into
account (0 for Last Row means the highest possible row number).

Batch Size

Specifies the row batch size (number of rows per commit). The
default value of 1000 should not be changed.

Error File

Enter here (directly or by using the Browse button) the file in
which rejected data will be stored.

Browse...

Use this button to display the Standard File Browser and select
a file name.

Stop on Error

Select this check box if you want Release Builder to stop the
execution of the current BCP Job whenever an error occurs.

Line Separator

Specify the string used as a line delimiter. The default value is
usually suitable, however you can choose any of the options
provided (in the combo box) or click the Custom check box
which lets you enter a series of hexadecimal values (delimited by
semicolons).

Field Separator

Specify the string used as a field delimiter. The default value is
usually suitable, however you can choose any of the provided
options (in the combo box) or click the Custom check box which
lets you enter a specific string value.
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Text BCP Options dialog box

Date/Time Fields

Specify the options concerning date/time field conversions. The
default values are usually suitable.

Handle Null Values as
'NULL

If activated, this option makes Release Builder generate and
handle the 'NULL' string in place of null values.
In addition to the improved legibility of the exported data, this
option might be very useful in order to differentiate an empty
string ('') from an actual NULL value. Without this option, an
empty string will be re-imported as a NULL value.

Data Preview >>

Click this button to show or hide the file preview part of the
dialog box. Note that this preview is re-calculated only if this part
is visible.

Preview part

This area displays a preview of file contents and lets you select
appropriate values for the Line and Field Separator.

OK

Click this button to validate your parameters and return to the
BCP Data Transfer dialog box.

Cancel

Click this button to cancel any changes in the current dialog box
and return to the BCP Data Transfer dialog box.

See Also
BCP Data Transfer dialog box
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Native BCP Options dialog box

Native BCP Options dialog box
This dialog box, which can be accessed from the BCP Options button of the BCP Data Transfer
dialog box (when the format of the current BCP Job is native), lets you set several parameters
concerning this Job's execution.

First & Last Row

Specifies the starting and ending number of the rows taken into
account (0 for Last Row means the highest possible row number).

Batch Size

Specifies the row batch size (number of rows per commit). The
default value of 1000 should not be changed.

Max. Error

Specifies an integer value for the maximum number of errors
tolerated before BCP Job execution is stopped.

Error File

Enter (directly or by using the Browse button) the file where
errors and rejected data will be written.

Browse...

Use this button to display the Standard File Browser and select
a file name.

OK

Click this button to validate your parameters and return to the
BCP Data Transfer dialog box.

Cancel

Click this button to cancel any changes in the current dialog box
and return to the BCP Data Transfer dialog box.

See Also
BCP Data Transfer dialog box
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Column Assignment Value dialog box

Column Assignment Value dialog box
This dialog box, which can be accessed by clicking Column Assignments in the BCP Data
Transfer dialog box, lets you make assignments between table columns and file fields for the
current BCP Job (when in Text format).

Columns

This section shows the column names of the current table
(of the current job).

DataType

Lists the types of each table column with their propriety
(such as <Id> for identity and <!N> for not null).

Assignment

This part of the column list displays the current assignment
of each column with the file fields.

File Fields

This list contains the list of fields found in the parsed source
file (in the case of Import Job).

Field Preview

This edit frame displays a preview of the selected field (in
the File Field list box) for the first lines (the preview size can
be specified in the BCP Transfer tab).

Assign

Click this button to assign the selected column(s) with the
selected field.
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Column Assignment Value dialog box

Assign to Value

Click this button to assign the selected column(s) with the
constant value or the identity value (depending on the
attribute of the column) specified in the bottom of the
dialog.

Null / Remove

This button, named Null in case of BCP Import and
Remove in case of BCP Export, respectively allows you to
assign a column with a NULL value and remove a column
from the list of exported data fields.

Restore Defaults

Click this button to restore the default assignment of the
columns.

Identify Value
Please note that
this section will
only become
active if you:
●

●

●

Auto (SQL
Server)

Specify that the identity value of the column is controlled by
the SQL Server (default setting).

choose an
Import
type job
select the
SQL-Text
Mode option
in the BCP
Job
Properties
dialog box

Controlled Enables you to set up particular values to be assigned with
by Client
an identity column by using the Offset and Increment fields.

have one
Identity
type column

Offset

Enter the offset value for the identity column (the first
inserted row will be affected with this value) here.

Increment

Enter the increment value for the identity column (1 by
default) here.

Numeric

Enter a numeric value to be assigned with the selected
column(s) here.

String

Enter a character string to be assigned with the selected
column(s) here. Use this field to specify any data type
having an implicit conversion from char (datetime for
instance).
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Column Assignment Value dialog box

Save as Format-File

Click this button to save the current column assignment
information into a format file (extension .fmt). This format
file may then be used as a parameter for the command line
utility bcp (please refer to the SQL Server documentation
for further details).

OK

Click this button to validate your parameters and return to
the BCP Data Transfer dialog box.

Cancel

Click this button to cancel any change in the current dialog
box and return to the BCP Data Transfer dialog box.

See Also
BCP Data Transfer dialog box
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Current BCP Profile dialog box
This dialog box, (which can be launched by clicking the Save button in the BCP Data Transfer
dialog box), lets you set various parameters for the current BCP Profile and save it in a local file.

File Name

Specify here (directly or via the Browse button) the file used to
store the current BCP Profile.

Save the whole BCP Job
list into Profile

Select this check box if you want to save the entire BCP Job list
into the profile (by default).

Save the currently
Selected Jobs only

Select this check box if you want to save only the current BCP Job
in the profile.

Profile date (from
Server)

Displays the current SQL Server date (stored in the profile).

Description

Enter a short comment to describe the current profile, such as
the database(s), what kind of Job is included and its purpose, etc.

Save

Click this button to save the current BCP Profile into the specified
file (a message box will tell you if the operation is successful).

OK

Click this button to validate your parameters and return to the
BCP Data Transfer dialog box.
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Current BCP Profile dialog box

Cancel

Click this button to cancel any changes in the current dialog box
and return to the BCP Data Transfer dialog box.

See Also
BCP Data Transfer dialog box
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BCP Profile Details dialog box
This dialog box is displayed when a BCP Profile is about to be loaded from a local file (Load
button in the BCP Data Transfer dialog box). It displays various information about the profile and
asks you to confirm its loading.

BCP Job Count

Displays the number of the BCP Jobs stored in the BCP Profile
about to be loaded.

Last Update

Displays the date (server date stamp) when the profile was last
saved.

Description

Displays the description comment associated with the profile.

File Size on Disk

Indicates the physical size (in bytes) of the profile on disk.

OK

Click this button to confirm and start loading the BCP Profile.

Cancel

Click this button to cancel BCP Profile loading.

See Also
BCP Data Transfer dialog box
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In Progress dialog box

In Progress dialog box
This dialog box shows the status and progress of an Script Extraction or BCP Transfer process.

Statistics >>

Not available in the current release.

Current state

Shows the current status of the process (Receiving data, Writing
output files, etc.)

Output file

Displays the name of the file currently being written to.

Current type

Shows the type of object that is currently being processed.

Current object

Displays the name of the object that is currently being processed.

Current job

Shows the current BCP Job number and its type (format and
direction).

Source

Shows the current source table or file (depending on the current
job).

Destination

Shows the current destination table or file (depending on the
current job).
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In Progress dialog box

Current state

Shows the current status of the running job (row count for
example).

Advance Scale...

Shows the progress of the Script Extraction process in
percentage. This scale can show global process or current
type/job progress depending on the Global Process Indicator
option specified in the BCP Transfer tab.

Cancel...

Click this button to stop the process. You will be prompted for a
confirmation. If you really want to stop the process, output
scripts (in the case of a Script Extraction Process) and current
BCP Export file (in the case of a BCP Transfer) will no longer be
valid; otherwise the operation will resume.

See Also
Script Extraction Assistant | BCP Transfer/Bulk Copy
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Job Reordering dialog box
This dialog box is displayed when you create two or more BCP import jobs with the BCP Job
Creation dialog box and then click the Reorder button in the BCP Data Transfer dialog box.

Reorder according to
This section allows you to automatically re-order the jobs in the BCP Data Transfer dialog box
according to their primary and foreign keys (re-order by Referential Constraint is not available).
Release Builder will examine the primary/foreign keys associated to the tables in the job list, and
will re-order the jobs so that any necessary delete or truncate processes are carried out
correctly.
For example, Table A has a foreign key pointing to a primary key in Table B. If Table A is part of
Job 1 that is located in the job list below Job 2 containing Table B, then the reorder proces will
put Job 1 above Job 2.
Consider
This section allows you to choose which Import Jobs will be included in the reorder process:
●

●

Only Selected Jobs (x) > Selecting this option will only reorder the jobs that you
selected in the job list.
All Import Jobs within the List > Selecting this option will force ALL the jobs in the job
list to be reordered regardless of the selections you make in the list.

See Also
BCP Data Transfer dialog box | BCP Job Creation dialog box
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Miscellaneous Items

Miscellaneous Items
The items described on this page can be accessed from various different Release Builder
processes. Select an item from those listed below:
●

Advanced File Options dialog box

●

Advanced Options (Substitution Map) dialog box

●

Assistant Description dialog box

●

Dropped Objects dialog box

●

In Progress dialog box
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Advanced File Options dialog box

Advanced File Options dialog box
This dialog box which can be accessed by:
●

●

clicking the File Options button in Delta Script Options Wizard of the Database
Comparison Assistant.
or by clicking the File Options button in the Scripts Destination Files Wizard of the Script
Extraction Assistant

is used to precisely specify the target files for the delta files.

Granularity
This set of options enables you to choose whether you want to extract each object type into
one file (One File by Type) or each object into corresponding individual files (One File by
Object).
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Advanced File Options dialog box

If you select One File by Object, you need to choose a structure that enables you to
automatically create the name of each individual file (that will contain each individual object). In
order to do this, a set of Key Words ( <ObjectName>, <Increment> etc...) are available (click
Insert Special Expression). These key words enable you to display the object's name, an
increment etc... in the generated file's name.
Drop Script Destination
Into Separate Files

Select this option to generate the Drop Script in separate files
(this is the default setting).

At the beginning of the
Create Scripts

Select this option to include Drop Script at the beginning of each
creation script.

Into One Single File

Select this option to include all the Drop Script for each object
type in a single file.

Base Directory
This text box displays the directory used as a Base Directory for the target files.
Type Destination
This section enables you to choose the destination of the scripts for each type of object. You
can select the object type in list on the left hand side of the dialog box.
Notes
●

If you have chosen to create one file per obejct type, you need to choose a file in the
Create Script and Drop Script zones using the Browse button.
If, on the other hand, you have chosen to create one file per object, you need to choose
a directory for each type in the Create Script and Drop Script zones using the Browse
button.

●

Please make sure that you define valid names for your files.
When you select the option One File by Object and have the key word <ObjectName>
in the structure of the destination file, errors may occur if you attempt to extract an object
with a name that contains spaces or non-supported characters in the destination file
name.

See Also
Delta Script Options Wizard | Scripts Destination Files Wizard

file:///D|/AVICENNE/DOC/eiffel/Userdoc/Sybase/MASTER/RELBLD/Features/Misc/AdvFileOpt.htm (2 of 2) [10/07/2008 11:53:47]

Advanced Options (Substitution Map) dialog box

Advanced Options (Substitution Map) dialog box
This dialog box can be accessed by:
●

clicking Advanced in either the Save Release Profile dialog box or the Compare Options
dialog box

It allows you to edit a substitution map to be applied to the body of all objects retrieved from the
server in the current profile.
This functionality is useful with the database comparison feature for which you can use
templates - these can be accessed from the Database Comparison tab. For example, if you want
to compare a database named "Dev" with a database named "Prod" you may want to ignore
words such as "Dev" or "Prod" in your comparison. Use this functionality to replace the current
database name with the other database name in one of the two database profiles (for example
you could replace "Dev" with "Prod" in the profile of the database called "Dev").
For instance:
Creation of GetListObjects procedure in CASTpubs database:

Create Proc dbo.GetListObjects
As
Begin
select name, xtype, uid
from CASTpubs..sysobjects
end
Creation of GetListObjects procedure in pubs database:

Create Proc dbo.GetListObjects
As
Begin
select name, xtype, uid
from pubs..sysobjects
end
If you carry out a comparison between CASTpubs and pubs (for example), no differences will
be detected by the Database Comparison Assistant using the parameters displayed in the dialog
box below:
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Advanced Options (Substitution Map) dialog box

Search for

Enter a string or database name (using the
drop-down list) to be searched for.

Replace by

Enter the replace value. Note: you may leave
this blank to remove all occurrences of the
search string.

Don't show system databases

Select this check box to hide or show the
system databases in the "Search for" combo
box.

Apply substitution to source
profile/database

Click this option if you want the substitution
map to be applied to the source profile or
database.
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Advanced Options (Substitution Map) dialog box

Apply substitution to target
profile/database

Click this option if you want the substitution
map to be applied to the target profile or
database.

New, Add/Modify, Delete

Use these buttons to clear the search and
replace fields or to edit the list view contents.

See Also
Save Release Profile dialog box | Compare Options dialog box | Database Compare tab
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Dropped Objects dialog box

Dropped Objects dialog box
This warning dialog box is displayed by Release Builder when a Release Profile containing
dropped objects is loaded. These objects are referenced in the profile but no longer exist in the
current database.
Release Builder informs you that an extraction operation could not be performed with these
objects.

Copy to clipboard

Click this button to copy the contents of the list box into the
clipboard (which lets you keep track of dropped object names).

Object list

Displays the list of the dropped objects found in the profile. The
list contains the name of each dropped object and its type (inside
brackets).

OK

Click this button to close the dialog box.
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Source Manager Interface

Source Manager Interface
●

What is the Source Manager Interface?

●

Installing the Source Manager

●

Using archives with a Source Manager

●

SCC Interface Manager
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What is the Source Manager Interface?

What is the Source Manager Interface?
CAST provides a Source Manager Interface for use with SQL-Builder and Release Builder,
enabling you to interface with Source Managers that support Microsoft's Source Code Control
(SCC) interface.
The interface enables you to extract objects from your source manager (check out), modify
them (in SQL-Builder) and/or create them on a server (SQL-Builder and Release Builder). You
can also copy objects into your source manager (check in) from SQL-Builder or Release Builder.
In addition you can display histories, reports on archives, set options, etc. depending on the
Source manager you are using.
Microsoft's Source Code Control (SCC) interface is the Microsoft Common Source Code
Control API (also called SCC API or SCCI). Currently we only support the Microsoft SCC API, not
the specific API from the Source Manager system vendor. This is because when SQL-Builder,
Release Builder & source control systems are used together, the link or interface is SCC system
calls.
Generally one Source Manager product has at least two APIs: the proprietary API and the
Microsoft SCC API. Most Source Manager vendors have an SCC API that can be used to access
the functionality of their product. Vendors offer their own API and the Microsoft SCC API, which
in fact acts as a standard API.
CAST Tools connect to a specific vendor using the Microsoft SCC API to have access to the
product
See Microsoft SCC Interface Manager for more information about using this source control
interface.
See Also
SCC Interface Manager | Using archives with a Source Manager
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Installing the Source Manager Interface

Installing the Source Manager Interface
CAST provides an automatic Source Manager installation process as part of its setup program. If,
however, you choose not to install the Source Manager interface during the setup procedure, you
can run the process manually at a later date. Instructions are given below:
Manual Installation
The CAST Source Manager interface is implemented via a specific DLL in the CAST installation
folder:
●

SrcMg32.DLL

This DLL is shipped by CAST and in its default state, no source manager or version control is
available in either SQL-Builder or Release Builder. In order to activate the Source Manager, you
need to replace this default DLL with the source manager DLL (SccMg32.DLL) shipped by CAST
and stored in the "SrcMngr" folder.
1. Locate and copy the source manager DLL in the "SrcMngr" folder.
2. Paste it to the CAST installation folder.
3. Change the name of the default "SrcMg32.DLL" to "SrcMg32OLD.DLL".
4. Change the name of the copied source manager DLL to the generic name "SrcMg32.DLL".
5. Launch either SQL-Builder or Release Builder as appropriate.
Notes
●

●

CAST will not run if there is no SrcMg32.DLL file in the CAST installation folder.
Please note that SQL-Builder does NOT support the check in /check out of table. This is
only possible when using Release Builder. This is due to the complex nature of the script
in the tables.

See Also
What is the Source Manager Interface?
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Using archives with a Source Manager

Using archives with a Source Manager
To open an archive with CAST Products, this object must have already been checked-in by
CAST Products.
If archives that have not been checked-in by CAST Products already exist, check them out,
create them on your server and then check them in with Release Builder. Your archives are then
ready to be used by CAST products.
Moreover, some workfile/archives extensions are automatically associated with some types of
objects in SQL-Builder and Release Builder:
TABLE

.tab

PACKAGEBODY

.pkb

PROCEDURE

.pro

PACKAGE

.pka

TRIGGER

.tri

SEQUENCE

.seq

INDEX

.idx

CLUSTER

.clu

VIEW

.vew

DBLINK

.dbl

TABLE_DATA

.txt

SYNONYM

.syn

RULE

.rul

TYPEBODY

.otb

DEFAULT

.def

TYPEHEADER

.oth

UDT

.udt

REFRESHGRP

.rfg

FUNCTION

.fct

SNAPSHOTLOG

.snl

PRIVILEGE

.prv

SNAPSHOT

.snp

USERGROUP

.usr

-

-
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S.C.C Interface Manager

S.C.C Interface Manager
The S.C.C. Interface Manager (SccMg32.DLL) provides access to a source manager via S.C.C.
(Source Code Control). In this way, you can work with the Version Control or Configuration
Management tools supporting the Source Code Control (S.C.C.) Interface implemented by
Microsoft.
The following options are available:
●

SCC Build Script from Archives dialog box

●

SCC Check in dialog box in SQL- Builder

●

SCC Check in dialog box in Release Builder

●

SCC Check-Out dialog box - Special Cases

●

SCC Advanced Menu (SQL Builder only)
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SCC Build Script from Archives dialog box

SCC Build Script from Archives dialog box
This dialog box, which can be launched via the SCC Manager > Build Script from Archives...
command allows you to define a selection of objects to be extracted from your source manager
(check-out).
Project Name

This field contains the name of the project in which your archives
are stored.
You may use the browse button [...] to change this project. Note
that this name is given back by the Source manager you are
interfaced with when you select the project.

Workfile Directory

This field contains the working directory.
You may use the browse button [...] to change this directory via
a directory browser if your source manager supports it.

Archive Selection

This shows the file mask used to filter archives (by default *.*).
Only the " * " wildcard can be used.

Selected objects

This list displays the archives found which correspond to the
"archive selection" filter. You can select one or multiple items to
perform commands on. You can update this list with the Update
button.

Options

Display advanced check out options if supported by your source
manager.

Properties

Display properties on the selected archive (if only one archive is
selected) if supported by your source manager.

History

Display the history on the selected archive (if only one archive is
selected) if supported by your source manager (see also SCC
Manager/History Report... Command).

Undo Check Out

Active if selected archives are checked out and if this command is
supported by your source manager.

Check Out

Click this button to start building the list of versions selected in
the list.

Notes
●

Please consult the SCC Build Script from Archives dialog box - Special Cases page for more
information about checking out files when using certain SCC Managers, notably Object
Cycle.
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SCC Check-In dialog box (SQL-Builder)

SCC Check-In dialog box (SQL-Builder)
This dialog box, which can be launched via the SCCManager > Check In... command, allows
you to copy your current object into your source manager via SCC, creating a new version of the
file.
Project Name

This field contains the name of the project in which your archive
is (will be) stored.
You may use the browse button [...] to change this project if the
current object is not already linked with an archive (if it has not
been opened from a checked-out archive). Note that this name is
given back by the Source manager you are interfaced with when
you select the project

Comment

You can specify a comment for all the archives if your source
manager supports it.

Options

Some options may be specified for the check in if it is supported
by your source manager.

Notes
●

The name, type and workfile path of the current object are also displayed. The project in
which you are going to check-in your archive is also displayed in the title of this dialog
box.
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SCC Check In dialog box (Release Builder)

SCC Check-In dialog box (Release Builder)
This dialog box, launched via the SCC Manager > Check In... command, allows you to copy
your currently selected objects into your source manager, creating a new version of the files.
An explanation of the options available in this dialog box follows:
Comment

You can specify a comment for all the archives if your source manager
supports it.

Workfile Path

You can define a workfile path for each archive, but take care of the possible
working directory specified in your source manager.

Options

Various options may be specified for the check in if it is supported by your
source manager.
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SCC Build Script from Archives dialog box - Special Cases

SCC Build Script from Archives dialog box - Special Cases
When using the Source Manager Object Cycle, you CANNOT check out files that you do not
already have stored on your PC.
You must first use the Get command to download the files that you want to check out AND then
use the Build Script from Archives command.
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SCC Advanced Menu (SQL-Builder only)

SCC Advanced Menu (SQL-Builder only)
When connected to your source configuration manager, a right click contextual menu is available
in the Object Manager, under the SCC node:

This menu option allows you to access the following SCC options:
●

Change SCC Project - this option is not available on a Type node or the root SCC node

●

Get Latest Version

●

Check Out

●

Check In

●

Unlock Archive

Shortcut Keys
Toolbars
Command Line
.INI File Options
Limitations
Regular Expressions
Appendix
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SCC Advanced Menu (SQL-Builder only)
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Shortcut Keys

Shortcut Keys

F1

Launches the on-line Help

F3

Use this command to find the next occurrence of the pattern or string
entered in the Find dialog box.

ALT+F4

Close all windows and exit Release Builder.

CTRL+F4

Use this command to close the active window or document.

CTRL+A

Selects all text in active document.

CTRL+B

Launches the BCP Transfer/Bulk Copy.

CTRL+C

Copies the selected item and places it in the clipboard.

CTRL+D

Launches the Database Comparison Assistant.

CTRL+E

Use this command to open a new SQL script editing window.

CTRL+F

Use this command to display the Find dialog box. You can use this
dialog box to locate text in the current document.

CTRL+H

Launches the Command Line Assistant.

CTRL+M

Launches the Release Profile Manager.

CTRL+N

Use this command to open a new connection to a server.

CTRL+O

Use this command to open any Script file (SQL) with the internal editor
or with an external editor (specified via the General tab) that can
support it.

CTRL+P

Launches the standard Windows Print dialog box, which enables you to
specify various print parameters.

CTRL+R

Launches the Script Extraction Assistant.

CTRL+S

Saves the active User Window.

CTRL+T

Launches the Release Builder Assistant enabling you to select the
process you require.

CTRL+V

Pastes the contents of the clipboard at the insertion point.

CTRL+X

Cuts (removes) the selected text or object and places it in the clipboard.

CTRL+Y

Re-does actions undone with the Undo command.
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Shortcut Keys

CTRL+Z

Cancels the previous commands' actions

SHIFT+CTRL+E

Highlight an .SQL file in the Report window and then select the option.
An editor window will then be launched, depending on the option
(internal or external) set in the General tab.
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Toolbars

Toolbars
Standard Toolbar
Equivalent Toolbar Command
Button

(Menu/Option)

Description of the action performed
Enables you to open a new connection to a
new or existing server.

File > New Connection

File > New SQL Script

File > Open File

If a connection is available the Connection
Manager dialog box will be launched, if NOT,
the Open Profile Connection dialog box will be
launched.
Opens a new SQL-Editor for script editing.
Launches a standard Windows Open dialog
box enabling you to open SQL script files
(.SQL) to edit.

File > Save

Saves the active User Window.

Edit > Cut

Removes the currently selected data from
the document and places it in the clipboard.
This command is not available if no data has
been selected. Cutting new data replaces the
contents of the clipboard. This function is not
available in a Read-Only editor.

Edit > Copy

Copies the selection into the clipboard.

Edit > Paste

Use this command to insert a copy of the
clipboard contents at the insertion point. This
command is not available if the clipboard is
empty or if the active editor is Read-Only.
Newly copied data replaces the data selected.

SQL-Server > Release Builder
Assistant
SQL-Server > Script Extraction

Launches the Release Builder Assistant
enabling you to select the process you
require.
Launches the Script Extraction Assistant.
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Toolbars

SQL-Server > Release Profile
Manager...
SQL-Server > Database Comparison
SQL-Server > BCP Transfer
Tools > Command Line Assistant

File > Edit Current File

File > Send File to SQL-Builder

File > Print

Launches the Release Profile Manager.
Launches the Database Comparison Assistant.
Launches the BCP Transfer.
Launches the Command Line Assistant.
Highlight an .SQL file in the Report Window
and then select the option. An editor window
will then be launched, depending on the
option (internal or external) set in the General
tab.
Highlight an .SQL file in the Report Window
and then select the option. The file will be
opened in SQL-Builder.
Prints the active document.

Help > About

Launches the About dialog box displaying
various information about the version of
Release Builder you are running.

Help > Index

Launches the default index page of the
Release Builder on-line Help.

Notes
●

You can show or hide the toolbar buttons should you require, by clicking the View menu
located on the toolbar and then selecting Toolbar.
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Command Line

Command Line
The following parameters can be used to run Release Builder from the command line. Some
examples are available here.
HELP
CONNECT
CONNECT_PROFILE
REPORT
EXTRACT
DELTA
BUILDRPF
BCP
SHOW
EXIT
Examples
Notes
●

Please make sure you use uppercase letters to input the command line parameters (as
in -REPORT, -EXIT). The procedure will fail otherwise.
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.INI File Options

.INI File Options
●

GloballySharedSettings.ini File Options
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GloballySharedSettings.ini File

GloballySharedSettings.ini File
This page describes how to add various parameters to the GloballySharedSettings.ini file
(located in your \Documents and Settings\All Users\Application
Data\CAST\CAST\<Version_Number> directory after installing CAST Products). These
parameters add supplementary features to all CAST applications.
Microsoft SQL-Server/Sybase ASE
Oracle Server
General
CAST Analysis Manager - Analyzers
ASP Analyzer
C++ Analyzer
Delphi Analyzer
EJB Assistant
Java Analyzer/J2EE Analyzer
JDO Assistant
Mainframe Analyzer
.NET Analyzer
PB Analyzer
PL/SQL Analyzer
T-SQL Analyzer
Analyzer Wizards
CAST Enlighten
Column Level Impact Analysis (CLIA)
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Limitations

Limitations
This application has some limitations. Please consult this non-exhaustive before contacting CAST
for error related problems.
●

Limitations (General)

●

Limitations (Server)

●

Limitations (Release Builder)
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Limitations (General)

Limitations (General)
●

Application crashes
After a crash, if you cannot restart a CAST application, you need to quit all CAST modules
and then explicitly kill the processes of all CAST modules that are still alive. Choose the
"Processes" tab in Windows Task Manager, check for the EXE names of CAST modules and
choose "End Process".

●

Version Consistency
The client and server components must be from the same release:

●

❍

Upgrade all client machines with CAST modules at the same time.

❍

Upgrade all Servers with CAST server side components at the same time.

❍

Do not install modules from different versions in the same directory.

❍

Do not install server side components from different versions on the same server.

Non detected network logins
If you have problems with detection of your network login, e.g. on a Novell Network, you
need to add an entry to your GloballySharedSettings.ini file:

[User]
RegisterLogin=1
You should alter this file before running Server Side Install. This option prompts an
additional connection dialog box when you launch a CAST Product. In this dialog box, you
will be prompted to enter your network login (domain\login). It will be used to distinguish
users in the Knowledge Base. When running a CAST Product via the command line
interface and this option is active, the most recently used login will be used.
●

Knowledge Base Performance
For performance reasons, you should regularly perform the command:
update statistics
in the Knowledge Base database. This will recreate all statistics information for the
Knowledge Base, which is vital for good performance of all CAST applications.

●

System Views
CAST System Views do not show COM objects created by IIS Analyzer. Workaround: As
COM objects are shared among all analyses, you can find the COM objects used by a
specific application through the Calling/Called Objects views.
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Limitations (Server)

Limitations (Server)
●

Sybase Servers with UTF-8 (Unicode) Character Set
CAST does not support such servers. This is because CAST products are a single-byte
character set application and Sybase's BCP functions do not provide conversion between
single-byte and multi-byte character sets such as UTF-8 as stated in the following Sybase
message:
SQL Warning: BCP insert operation is disabled when LONGCHAR capability is turned on and
data size is changing between client and server character sets since BCP does not support
LONGCHAR yet. (severity 16, msg# 4847, line# 1).
Workaround: Configure the server with a single-byte character set such as iso_1 or cp850.

●

Sybase temporary databases
CAST Products for Sybase ASE cannot use a user-created temporary database such as
tempdb_1 as their temporary database. Only the system temporary database tempdb can
be used. Sybase has introduced the multiple temporary database feature in Adaptive
Server Enterprise version 12.5.0.3. To use CAST Products on this version, you must make
sure that all sessions opened by CAST products are bound to tempdb rather than any usercreated temporary database.

●

Compatibility Levels on Microsoft SQL-Server
The parameter compatibility level of Microsoft SQL-Server is not taken into account by
CAST. You will get various errors when you set the "compatibility level" of Microsoft SQLServer to another version than your Microsoft SQL-Server version. For instance, for
Microsoft SQL-Server 2000, the compatibility level must be set to 80. The compatibility
level is set separately for each database within a SQL-Server instance. The restriction
applies only to databases used with CAST products. See Microsoft SQL-Server 2000
documentation on system stored procedure 'sp_dbcmptlevel' for more information on
setting the database compatibility level.
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Limitations (Release Builder)

Limitations (Release Builder)
●

Use of quotation marks for Index creation (Sybase ASE servers only)
When creating indexes, make sure you omit the quotation marks around the object name
(as indicated in red below):

create table test
(
col1 int not null,
col2 int not null
)
Set quoted_identifier on
create index xxx
on dbo.test ( col1 )
on 'default'
Script Extraction issues may arise if you ignore fail to do so.
●

Source Manager Interface
It is not possible to check-in or check-out Tables with CAST's Source Manager interface.
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Regular Expressions

Regular Expressions
A Regular Expression is a pattern description using a "meta language", a language that you
use to describe particular patterns of interest. The characters used in this "meta language" are
part of the standard ASCII character set used in UNIX and MS-DOS, which can sometimes lead to
confusion. The characters that form regular expressions are:
.

[], ^, -

Matches any single character.
A character class which matches any character within the brackets. If the first
character is a circumflex (« ^ ») it changes the meaning to match any character
except those within the brackets. A dash (« - ») inside the square brackets
indicates a character range, e.g., « [0-9] » means the same thing as «
[0123456789] », « [^A-Z] » matches any single character except A to Z upper case
letters.
Except inside character classes (« [...] »), this makes the next character lose its
special meaning, e.g., « \* » is a literal asterisk.
When this appears just before a letter r, n or t: \r, \n, \t respectively matches a
carriage return, a line feed, or an horizontal tab.
Only in Universal Analyzer description files (named xxxLanguagePattern.xml in
folder $CAST_INSTALL\configuration\universal\xxx):

\

●

●

[\r\n]+

\x followed by one or two hexadecimal digits matches the corresponding
character for digits' value, e.g. « \x41 » matches an «A», « \xA » matches a
line feed. Such characters never have a special meaning, e.g. « \x2E »
matches a literal dot (same as « \.»).
Inside character classes, a \ makes the next character lose its special
meaning, e.g. « [\^\\A\-\]\r\n\t] » matches one of the following characters:
«^», «\», «A», «-», «]», a carriage return, a line feed, or an horizontal tab.

Use the expression [\r\n]+ to match one or many carriage returns (\r) and/or
line feeds (\n).
Matches one or more occurrences of the preceding regular expression.

+

*

For example: [0-9]+ matches « 1 », « 111 », or « 123456 » but not an empty
string (if the plus sign were an asterisk, it would also match the empty string).
Matches one or more occurrences of the preceding regular expression or an empty
string.
For example: [0-9]* matches « 1 », « 111 », « 123456 » or an empty string « ».
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Regular Expressions

Matches zero or one occurrence of the preceding regular expression.
?

For example: -?[0-9]+ matches a signed number including an optional leading
minus.
Matches either the preceding regular expression or the following regular expression.

|

For example: Cow|pig|sheep matches any of the three words.
Groups a series of regular expressions together into a new regular expression.

()

For example: (01) represents the character sequence 01. Parentheses are useful
when building up complex patterns with *, +, ?, and |.

Note that some of these operators operate on single characters (e.g., []) while others operate
on regular expressions. Usually, complex regular expressions are built up from simple regular
expressions.
Examples of how to use Regular Expressions follow:
First, the regular expression for a « digit » is:
[0-9]
This can be used to build a regular expression for an integer:
[0-9]+
... for which at least one digit is required (this would have allowed no digits at all: [0-9]*)
Let's add an optional unary minus:
-?[0-9]+
This can then be expanded to allow decimal numbers. First, a decimal number can be specified
(for the time being the last character will always be a digit):
[0-9]*\.[0-9]+
Note that the « \ » before the period will make it a literal period rather than a wild card
character. This pattern matches « 0.0 », « 4.5 », or « .31415 ». However, it does not match « 0
» or « 2 ». In order to combine the definition to match them as well, simply leave out the unary
minus, and use the following instead:
([0-9]+)|([0-9]*\.[0-9]+)
In this example, the grouping symbols « () » are used to specify what the regular expressions
are for the « | » operation. If the unary minus is added :
-?(([0-9]+)|([0-9]*\.[0-9]+))
This can be furthered by allowing a float-style exponent to be specified as well. First, here's an
example of a regular expression for an exponent:
[eE][-+]?[0-9]+
This matches an upper, or lowercase letter E, then an optional plus or minus sign, then a string
of digits. For instance, this will match « e12 » or « E-3 ». This expression can then be used to
build our final expression, one that specifies a real number:
-?(([0-9]+)|([0-9]*\.[0-9]+)([eE][-+]?[0-9]+)?)
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Regular Expressions

Valid number: .65ea12
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Appendix

Appendix
●

Changes to CAST .INI files

●

User privileges in Microsoft SQL-Server 2005 environments
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Changes to CAST .INI files

Changes to CAST .INI files
In version 5.1.1, CAST changed the way in which it manages its .INI configuration files. These
changes are transparent and you do not need to manually make any changes, however,
this help page summarizes the changes that have been made:
In versions 5.1.0 and below, CAST used a general .INI configuration file (cw.ini) located in the
WINDOWS/WINNT folder. In version 5.1.1 and above, this file has now been replaced with a
new .INI file called GloballySharedSettings.ini. This file is now located in a user specific
Application Data folder.
To summarize:
v. 5.1.0 and below
File name

Location

cw.ini

WINDOWS
or WINNT
folder

v. 5.1.1 and above
File name

Location

\Documents and Settings\All
GloballySharedSettings.ini Users\Application
Data\CAST\CAST\<Version_Number>

In addition, there are other application specific .INI configuration files whose storage location has
also been changed. Among these are the following .INI configuration files which are referenced
elsewhere in the on-line Help:
●

anaman.ini

●

adgadmin.ini

●

enlighten.ini

●

enlightenS.ini

●

enlightenU.ini

●

rbo.ini

●

relbuild.ini

●

rcenter.ini

●

servman.ini

●

sqlbuild.ini

●

sqlbldo.ini

The location of these files has changed as follows:
v. 5.1.0 and below

v. 5.1.1 and above

Location

Location
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WINDOWS or WINNT folder

\Documents and
Settings\<User_Name>[.<Domain_Name>]\Application
Data\CAST\CAST\<Version_Number>

You can find out more about the options contained in these .INI configuration files here.
See Also
.INI File Options
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In a properly configured CAST environment, the CAST administrator will create RDBMS logins for
use with CAST products (CAST Analysis Manager, CAST Enlighten, CAST Report Center etc.) that
do not have the same access privileges as the powerful "sa" or "sysadmin" logins. This is to avoid
a situation where a standard user could gain access to sensitive material or configuration settings
on the RDBMS.
In Microsoft SQL-Server 2005 environments, i.e. where the CAST Knowledge Base or CAST
Central Site are installed on a Microsoft SQL-Server 2005, the limited logins created specifically
for use with CAST products MUST be granted the VIEW SERVER STATE privilege.
This privilege grants access to the server’s current process list via master..sysprocesses or via
sys.dm_exec_requests. This information is required by CAST products for internal management
of database locking and the analyzer save process.
To avoid product usage errors, users will be prevented from accessing the database if their login
does not have access to the current process list.
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